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Safety

Safety Information

Do NOT service or repair this equipment unless
properly qualified. Servicing should be per-
formed only by a qualified technician or an
authorized Audio Precision distributor.

Do NOT defeat the safety ground connection.
This equipment is designed to operate only with
an approved three-conductor power cord and
safety grounding. Loss of the protective ground-
ing connection can result in electrical shock haz-
ard from the accessible conductive surfaces of
this equipment.

Do NOT exceed mains voltage ratings. This
equipment is designed to operate only from a
50—-60 Hz ac mains power source at 100—240 Vac
nominal voltage. The mains supply voltage is not
to exceed =10 % of nominal (90-264 Vac).

For continued fire hazard protection, fuses should
be replaced ONLY with the exact value and type
indicated on the rear panel of the instrument.

The International Electrotechnical Commission
(IEC 1010-1) requires that measuring circuit ter-
minals used for voltage or current measurement
be marked to indicate their Measurement Cate-
gory. The Measurement Category is based on the
amplitude of transient or impulse voltage that can
be expected from the ac power distribution net-
work. This product is classified as Measurement
Category I, abbreviated “CAT I” on the instru-
ment front panel, and it should not be used within
Categories II, III, or IV. It is intended to be used
for the measurement of audio signals only. The
maximum input rating at the measurement termi-
nals is 230 Vpk / 160 Vrms for the APx525 Fam-
ily, and 160 Vpk / 115 Vrms for the APx585
Family (dc to 20 kHz).

Do NOT substitute parts or make any modifica-
tions without the written approval of Audio Preci-
sion. Doing so may create safety hazards. Using
this product in a manner not specified by Audio
Precision can result in a safety hazard.

This product is for indoor use—Installation Cate-
gory I, Measurement Category I, Pollution
Degree 2.

Safety Symbols

The following symbols may be marked on the
panels or covers of equipment or modules, and
are used in this manual:

a potentially hazardous condition, such

as the presence of dangerous voltage that
could pose a risk of electrical shock. Refer to the
accompanying Warning Label or Tag, and exer-
cise extreme caution.

f WARNING!—This symbol alerts you to

to important operating considerations or

a potential operating condition that could
damage equipment. If you see this marked on
equipment, refer to the Operator’s Manual or
User’s Manual for precautionary instructions.

FUNCTIONAL EARTH
‘ TERMINAL—A terminal marked with
this symbol is electrically connected to a
reference point of a measuring circuit or output

and is intended to be earthed for any functional
purpose other than safety.

PROTECTIVE EARTH
@ TERMINAL—A terminal marked with
this symbol is bonded to conductive parts

of the instrument and is intended to be connected
to an external protective earthing system.

f ATTENTION!—This symbol alerts you

Disclaimer

Audio Precision cautions against using their
products in a manner not specified by the manu-
facturer. To do otherwise may void any warran-
ties, damage equipment, or pose a safety risk to
personnel.

APXx Series Service Manual
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Section 1: General Information

1.1 Introduction

This service package supports the Audio
Precision APx500 Series audio analyzers.
Sufficient information and tools are provided to
enable a qualified technician to perform
adjustments and diagnostic self tests. This manual
covers the APx525, 526, 555, 582, 585, and 586
instruments. Model designations APx520 and 521
are no longer used for new products—when
servicing these instruments refer to the APx525
and 526 respectively instead.

General service information in this package also
applies to the APx515; information specific to the
APx515 can be found in Section 8.

The service package download contains this
manual, as well as all the necessary adjustment
and Self Test projects. The adjustment projects
require a specific version of the APx500
measurement software, which is noted in the
accompanying Readme.txt file. If this version is
different than the version you are currently
running, it may be installed concurrently in a
separate directory.

1.2 Adjustment and Self Test
Adjustment is a procedure that directs you to
adjust variable components in one or more
instrument modules to achieve optimum
performance.

Self Tests are diagnostic procedures that use the
instrument’s own analyzer section to indicate
passing or failing performance in each of its
measurement functions.

1.3 Calibration CANNOT be performed
with this service package

Calibration requires specific testing equipment
and procedures to verify the performance of a
device against published specifications.

Accredited calibration adds a further degree of
rigor to the testing process, incorporating review
of quality system documentation as well as an
on-site assessment by an independent agency.
Contact Audio Precision or your AP sales partner
for information about accredited calibration
services.

1.4 Repair Authorization

The field repair of any APx500 Series circuit
board assembly or module is NOT authorized
except under very special circumstances.
Defective modules or assemblies will be replaced
through your local Audio Precision distributor or
our USA factory. See Section 2 for a brief
synopsis of the modules and assemblies
contained in the APx500 Series instruments.

1.5 Schematics and Design
Documentation

Audio Precision considers many of the circuit
designs used in the APx500 Series of instruments
to be proprietary and state-of-the-art. In the event
that Audio Precision authorizes a field repair to
one of the modules, only information sufficient to
locate and replace the defective component(s)
will be provided. No other schematics or design
related information will be released.

1.6 The System

Each Audio Precision APx500 Series instrument
functions in a system, controlled by a PC running
APx500 measurement software. The PC
communicates with the instrument over a USB
cable connection.

APx500 Series Service Manual
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Section 2: Functional Modules

2.1 Introduction

The APx500 Series is completely modular in
construction. This makes troubleshooting and
repair faster and easier. The following describes
the major modules and assemblies in the
instrument, in order to facilitate a basic
understanding of the function and layout. The
locations of the modules in the instrument are
shown in Section 3. The APx500 Series models
that use each module are indicated in brackets.

2.2 Common Modules

2.2.1 BPWR Power Supply Module

The power supply takes the ac line input voltage
and converts it to various dc voltages for
distribution within the instrument. A wide input
range eliminates the need for an ac voltage
selection switch. The power supply is located in a
self-contained enclosure, located in the rear of the
instrument, which can easily be removed. If a
failure is diagnosed to the power supply, the
entire module will be swapped for another. There
are no user-serviceable parts inside [All models].

2.2.2 BRIO Distribution Backplane
Mounted to the horizontal chassis plate that
internally divides the top and bottom halves of
the instrument. It contains multi-pin connectors
that most of the other circuit board modules
mount to, as well as circuitry for interfacing and
distributing signals between the modules. The
backplane also contains the +16 Vdc regulators,
and LEDs that indicate the proper operation of
each of the different power supply voltages [All
models].

2.2.3 BSL2 Advanced Master Clock Module
Generates clock and synchronization signals that
are used throughout the system, primarily for the

generation of synchronized audio sample rates
and jitter [APx555 (optional on others)].

2.2.4 BSOL Master Clock Module
Generates clock and synchronization signals that
are used throughout the system, primarily for the

generation of synchronized audio sample rates
[APx525, 526, 582, 585, 586].

2.2.5 BSRP Advanced Master Clock Rear
Panel

Rear panel with sync and trigger connectors
[APx555 (optional on others)].

2.2.6 BVIV Power LED Module

Holds the LED that lights up the front panel AP
logo when the power to the instrument is turned
on [All models].

2.2.7 BZOD CPU / USB Module

Contains the CPU and the USB interface that
carries communications between the APx
instrument and the PC running the APx500
measurement software [ All models].

2.3 Analog Output Modules

2.3.1 B4AO Analog Output Module
(High Performance 2-chan)

Contains the analog generator and output
circuitry for two channels. This is a large board
that resides on the left side of the chassis plate in
the top half of the instrument [APx555].

2.3.2 B4SG Analog Sine Generator Module
High Performance Analog Sine Generator.
Mounts over the B4AO Analog Output module
[APx555].

2.3.3 BLED Analog I/O LED Module (8-chan)
Holds the eight LEDs and the D-sub connector on
the analog input and output panels [APx585,
586].

APx500 Series Service Manual
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Section 2: Functional Modules

2.3.4 BMEG Analog Output Module (2-chan)
Contains the analog generator and output
circuitry for two channels. This is a large board
that resides on the left side of the chassis plate in

the top half of the instrument [APx525, 526, 582].

2.3.5 BOFP Analog Output LED Module
(2-chan)

Holds two LEDs and the XLR output connectors
on the front panel [APx525, 526, 555, 582].

2.3.6 BPLX Analog Output Module (8-chan)
Contains the analog generator and the output
circuitry for eight channels. This is a large board

that resides on the left side of the chassis plate in
the top half of the instrument [APx585, 586].

2.3.7 BSAT AG52 Analog Generator Module
(2-chan) (option)

Adds an analog square wave generator.
Additionally, it increases the maximum output
level, improves THD+N, and adds DIM
measurement capability (combined square wave
and sine wave stimulus signal) [APx525, 526,
582].

2.4 Analog Input Modules

2.4.1 B4Al Analog Input Module
(High Performance 2-chan)

Contains the analog analyzers and input circuitry
for two channels. This is a large board that resides
on the right side of the chassis plate in the top half
of the instrument [APx555].

2.4.2 B4BR Analog Band Reject Module
Analog Band Reject module for the High

Performance Analyzer capability. Mounts over
the B4AI Analog Input module [APx555].

2.4.3 BCAS Analog Input Module (8-chan)
Contains the analog analyzers and input circuitry
for eight channels. This is a large board that
resides on the right side of the chassis plate in the
top half of the instrument. On the APx586, there
is a second BCAS module in the bottom half
[APx582, 585, 586].

2.4.4 BIFP Analog Input LED Module
(2-chan)

Holds two LEDs and the XLR input connectors
on the front panel [APx525, 526, 555].

2.4.5 BLED Analog I/O LED Module (8-chan)
Holds the eight LEDs and the D-sub connector on

the analog input and output panels [APx582, 585,
586].

2.4.6 BOTA Analog Input Module (2-chan)
Contains the analog analyzers and input circuitry
for two channels. This is a large board that resides
on the right side of the chassis plate in the top half
of the instrument. On the APx521 and 526, there
is a second BOTA module in the bottom half
[APx525, 526].

2.4.7 BROT BW52 Ultra-high Bandwidth
Analyzer Module (2-chan) (option)

Extends the analog measurement bandwidth from
90 kHz out to 1 MHz [APx525, 526].

2.5 Digital /0 Modules

2.5.1 BADI Advanced Digital 1/0 Module
Provides digital I/O to the instrument, via the
various connectors on the BDIF panel [APx555].

2.5.2 BAES Digital /0 Module
Provides digital I/O to the instrument, via the

various connectors on the BSOP panel [APx525,
526, 582, 585, 586].

2.5.3 BAZL/BAZW Bluetooth Module
(option)

Provides Bluetooth connectivity. The BAZW
wideband version has different firmware but the
board is the same [APx525, 526, 555, 582, 585,
586].

2.5.4 BDIF Advanced Digital /0 Panel
Contains balanced, unbalanced, and optical

digital signal connectors. Internal cables carry
signals from BDIF to BADI [APx555].

2.5.5 BDIO Digital Serial I/O Panel (option)
Provides digital serial I/O via 4 DB15 connectors
mounted on a single-width panel. Connects

2-2
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internally to BDSA [APx525, 526, 555, 582, 585,
586].

2.5.6 BDSA Digital Serial I/0 Module
(option)

Contains the circuitry that adds serial digital I/O
capability [APx525, 526, 555, 582, 585, 586].

2.5.7 BMPA Digital Serial /0 Panel Upper
(option)

Contains connectors and circuitry for the upper
two DB15 connectors [APx525, 526, 555, 582,
585, 586].

2.5.8 BPDF PDM Panel (option)
Provides front panel LEDs and BNC connectors
[APx525, 526, 555, 582, 585, 586].

2.5.9 BPDM PDM Module (option)
Provides PDM I/O, with data, clock, and power
connectors [APx525, 526, 555, 582, 585, 586].

2.5.10 BSFP Digital I/O Panel

Contains balanced, unbalanced, and optical
digital signal connectors. Internal cables carry
signals from BSFP to BAES [APx525, 526, 582,
585, 586].

2.5.11 BSOP Digital I1/0 Panel (obsolete)
Contains balanced, unbalanced, and optical
digital signal connectors in a double-width panel.

Internal cables carry signals from BSOP to BAES
[APx525, 526, 582, 585, 586].

2.5.12 BTFP Bluetooth Panel (option)
Provides front panel LEDs and Bluetooth antenna
connectivity [APx525, 526, 555, 582, 585, 586].

2.5.13 BVID HDMI Module (option)
Provides HDMI front panel connections. It also
decodes HDMI audio, and contains the video
signal generator [APx525, 526, 555, 582, 585,
586].

2.5.14 BSIR, BDIO.BT, BDIO.PDM
Combination DIO Modules (option)

Combination DIO/Serial 10, DIO/BT, and DIO/
PDM modules (obsolete) [APx525, 526, 582,
585, 586].

2.6 Connector Revisions and BERT
Adapter

Earlier APx modules used Type M connectors for
internal module interconnection. When the Type
M connectors were no longer available, all
modules and chassis were revised to use Type E
connectors. The BERT adapter allows Type E
modules to be mounted in a Type M chassis.

APx500 Series Service Manual
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Table 1: Functional Modules Matrix

COMMON: APx525 APx526 APx555 APx582 APx585 APx586
BPWR Power Supply X X X X X X
BRIO Distribution Backplane X X X X X X
BSL2 Advanced Master Clock O O X

BSOL Master Clock X X X X X
BSRP Advanced Master Clock Panel O O X

BVIV Power LED X X X X X X
BZOD CPU/USB X X X X X X
ANALOG OUTPUT:

B4AO Analog Output (High Perf) X

B4SG Analog Sine Generator X

BLED Analog I/O LED X X
BMEG Analog Output (2-chan) X X X

BOFP Analog Output LED X X X X

BPLX Analog Output (8-chan) X X
BSAT AG52 Analog Generator 0] 0] X

ANALOG INPUT:

B4AI Analog Input (High Perf) X

B4BR Analog Band Reject X

BCAS Analog Input (8-chan) X X X
BIFP Analog Input LED X X X

BLED Analog I/O LED X X X
BOTA Analog Input (2-chan) X X

BROT i\é\;?jzg:tra-hlgh Bandwidth

Key: X=Present O=Option

CONTINUED ON NEXT PAGE
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Section 2: Functional Modules

Table 1: Functional Modules Matrix (continued)

DIGITAL I/O: APx525 APx526 APx555 APx582 APx585 APx586
BADI Advanced Digital I/0 0] 0] X 0] 0] 0]
BAES Digital 1/0 X X X X X
oaon [Bluetooth o o o 0 o o
BDIF Advanced Digital I/O Panel 0] 0] X 0] 0] 0]
BDIO Digital Serial 1/0 Panel @) @) @) @) @) @)
BDSA Digital Serial I/O 0] 0] 0] X 0] (0]
BMPA Digital Serial 1/0O Panel Upper 0] 0] 0] O O O
BPDF PDM Panel @) @) @) @) @) @)
BPDM PDM 0] @) @) @) O O
BSFP Digital 1/0 Panel X X X X X
BSOP Digital 1/0 Panel (obs) X X X X X
BTFP Bluetooth Panel 0] O O 0] O O
BVID HDMI 0 @) @) @) O O

Key: X=Present

O=Option

APx500 Series Service Manual
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Section 3: Mechanical Diagrams

3.1 Introduction

This section contains selected mechanical
drawings and replaceable parts lists for the APx
instrument. Unless otherwise specified, all

dimensions are in inches. When ordering a
replacement part, please include the instrument
model and serial number, in addition to the Audio
Precision part number and item description.

Abbreviations Used in the Mechanical Parts Lists

" Inch INTF Interface

# Number or size /o] Input/output

A Ampere LED Light emitting diode
AL Aluminum M Male

ANLR Analyzer MC Machine

ASSY Assembly M/F Male/female

AUX Auxiliary MOD Module

BAN Banana MON Monitor

BGE Beige MT Mount

BLK Black PAN Pan head

BO Black oxide PC Printed circuit

BZ Black zinc PH Phillips

COND Conductor PNL Panel

CONN Connector POLY Polyethylene
CONT Continuous PSA Pressure sensitive adhesive
C&S Cut and strip RBN Ribbon

D-SUB D-subminiature RND Round

ECB Etched circuit board RT Right

EL Electro-luminescent SEM SEMS captive washer
F Female SHLD Shield

FLT Flat head SS Stainless steel

Ga Gauge TF Thread forming
GEN Generator THRD Thread or threaded
GNDED Grounded TRS Truss head

GRY Grey VSEL Voltage selector
HDWR Hardware wi/ With

HEX Hexagonal wW/O Without

INSUL Insulated XFMR Transformer

INT Internal ZN Zinc

APx500 Series Service Manual
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Section 3: Mechanical Diagrams

Table 3-1: Covers

ITEM PART NO. DESCRIPTION QTY
1 7110.0300 COVER, BOTTOM 1
2 7150.0300 COVER, TOP 1
3 5630.0011 FOOT, BLACK .25 X .5 POLYASTERMER
5630.0001 FOOT, BLACK SIDE .5 X .5 X .25
4 5112.1108.7 SCREW FLT PH 100 DEG ZN 4-40 X 1/4 BLK 28
(REV 1 CHASSIS)
4 5112.1108.8 SCREW FLT PH 100 DEG ZN 4-40 X 1/4 GREY (28)
(REV 0 CHASSIS)
5 5112.1108.2 SCREW FLT PH 100 DEG ZN 4-40 X 1/4 6
6 5113.7112 SCREW MC SEM PH 2N 6-32 X 3/8 4
HAN-APX HANDLE (COMPLETE ASSY) 1
5810.0004 HANDLE STRAP 1
7310.0028 HANDLE BRACKET 2
5515.0004 HANDLE SPACER 2
5115.1116.2 SCREW FLT PH BLK 10-32 X 1/2 2
(REV 1 CHASSIS)
5115.1116.6 SCREW FLT PH DGY 10-32 X 1/2 @)
(REV 0 CHASSIS)
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Figure 3-1 Covers
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Section 3: Mechanical Diagrams

Table 3-2: Chassis Rev 0

ITEM PART NO DESCRIPTION QTY
1 7130.0101 PLATE, ADAPTER, FRONT PANEL 1
2 7400.0030 CASTING, FRONT PANEL 1
3 7310.0040 BRACE, VERT, FRONT 2
4 7310.0038 BRACKET, DIVIDER, ANALOG 1
5 7311.0001 BRACE, LEFT, HORIZ, CHASSIS 1
6 7310.0041 BRACE, VERTICAL, REAR 2
7 BRIO.0000 INTERCONNECT BOARD 1
8 4800.1250 FAN, 1.25 X 1.1 D 3" WIRES 24V 1
9 7310.0035 BRACKET, FAN, BULKHEAD 1
10 7140.0300 PANEL, REAR 1
1 BPWR.0000 POWER SUPPLY MODULE 1
12 7320.0026 CLIP, ATTACHMENT, POWER ROD 1
13 7311.0002 BRACE, RIGHT, HORIZ., CHASSIS 1
14 5670.0002 ROD, ACTUATION, POWER 1
15 BLOG.0000 FRONT SWITCH PANEL 1
16 5222.0001 NUT, KEP 4-40 22
17 5113.7108 SCREW MC SEM PH ZN 6-32 X 1/4 16
18 5112.3108 SCREW MC SEM PH ZN 4-40 X 1/4 8
19 5223.0001 NUT, KEP 6-32 10
20 5113.1108.8 SCREW, FLAT, ZINC, 6-32 X 1/4 X 100DEG 8
21 5113.7112 SCREW, PH, 6-32 X 3/8 5
22 5112.3144 SCREW, PH, 4-40 X 1 + 3/8 4
23 5112.1108.2 SCREW, FLAT, ZINC, 4-40 X 1/4 14
24 5112.3112 SCREW MC SEM PH ZN 4-40 X 3/8 3
25 5346.0002 WASHER, SHOULDER #4 2
26 5544.2233 BUSHING GUIDE NYLON .218 ID X .234 H 3
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Figure 3-2 Chassis Rev 0
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Table 3-3: Chassis Rev 1

ITEM PART NO DESCRIPTION QTY
1 7130.0101 PLATE, ADAPTER, FRONT PANEL 1
2 7400.0030 CASTING, FRONT PANEL 1
4 7310.0038 BRACKET, DIVIDER, ANALOG 1
5 7311.0001 BRACE, LEFT, HORIZ, CHASSIS 1
7 BRIO.0000 INTERCONNECT BOARD 1
8 4800.1250 FAN, 1.25 X 1.1 D 3" WIRES 24V 1
9 7310.0035 BRACKET, FAN, BULKHEAD 1
10 7140.0310 PANEL, REAR 1
1 BPWR.0000 POWER SUPPLY MODULE 1
12 7320.0026 CLIP, ATTACHMENT, POWER ROD 1
13 7311.0002 BRACE, RIGHT, HORIZ, CHASSIS 1
14 7159.0001 BAR, ACTUATION, POWER 1
5610.0004 HEAT SHRINK, 1 X 1/4 1
5620.0101 GROMMET 1
15 BLOG.0000 FRONT SWITCH PANEL 1
16 5222.0001 NUT, KEP 4-40 22
17 5113.7108 SCREW MC SEM PH ZN 6-32 X 1/4 16
18 5112.3108 SCREW MC SEM PH ZN 4-40 X 1/4 8
19 5223.0001 NUT, KEP 6-32 10
20 5113.1108.8 SCREW, FLAT, ZINC, 6-32 X 1/4 X 100DEG 8
21 5113.7112 SCREW, PH, 6-32 X 3/8 5
22 5112.3144 SCREW, PH, 4-40 X 1 + 3/8 4
23 5112.1108.2 SCREW, FLAT, ZINC, 4-40 X 1/4 14
24 5112.3112 SCREW MC SEM PH ZN 4-40 X 3/8 3
25 5346.0002 WASHER, SHOULDER #4 2
26 5544.2233 BUSHING GUIDE NYLON .218 ID X .234 H 3
27 5112.3112 SCREW MACH PAN PH ZN 4-40 X 3/8 2
28 5317.0003 WASHER, FLAT 3/16 ID X 3/8 2
4255.0002 JACK, BANANA GNDED KNURLED (REAR PANEL) 1
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Figure 3-3 Chassis Rev 1
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Table 3-4: Front and Rear Panels (2-chan).

ITEM PART NO DESCRIPTION QTY
1 BAOU.2000 ANALOG OUTPUT PANEL (2-CHAN) 1
(SEE FIGURE 3-14)
2 BAIN.2000 ANALOG INPUT PANEL (2-CHAN) 1
(SEE FIGURE 3-16)
2A BAIN.3000 ANALOG INPUT PANEL CHANNELS 3&4 (2-CHAN) | (1)
(APX526 ONLY) (SEE FIGURE 3-16)
3 BDFP.0000 ADV DIGITAL IO PANEL (SEE FIGURE 3-18) (1)
BSPS.0000 DIGITAL 10 PANEL (SEE FIGURE 3-19) (1)
4 7134.0136 PANEL, BLANK, SMALL (QTY AS NEEDED) (0-4)
BHDM.0000 HDMI I/O PANEL (OPTIONAL) (SEE FIGURE 3-25) | (1)
AND (SEE FIGURE 3-26)
6 BTFP.0000 BLUETOOTH I/0 PANEL (OPTIONAL) (SEE FIGURE | (1)
3-27)
7 BDIO.0000 DIGITAL SERIAL /0O PANEL (OPTIONAL) (SEE FIG- | (1)
URE 3-29)
8 BPDF.0000 PDM I/0 PANEL (OPTIONAL) (SEE FIGURE 3-28) (1)
9 BSLR.0000 ADV MASTER CLOCK REAR PANEL (1)
7134.0150 PLATE, BLANK, REAR (REV 1 CHASSIS) (1)
10 7134.0130 PLATE, BLANK, REAR (REV 0 CHASSIS) 2
11 5112.1108.7 SCREW FLT PH 100 DEG AN 4-40 X 1/4 BLACK 24-28
(REV 1 CHASSIS)
5112.1108.8 SCREW FLT PH 100 DEG AN 4-40 X 1/4 GREY (24-28)
(REV 0 CHASSIS)
12 5112.1108.2 SCREW FLT PH 100 DEG ZN 4-40 X 1/4 6
(REV 1 CHASSIS)
13 5112.3108 SCREW MC SEM PH ZN 4-40 X 1/4 (8)
(REV 0 CHASSIS)

Option quantities are shown in parentheses.
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Figure 3-4 Front and Rear Panels (2-chan)
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Table 3-5: Front and Rear Panels (8-chan).

ITEM PART NO DESCRIPTION QTY
1 BAOU.0000 ANALOG OUTPUT PANEL (8-CHAN) 1
(SEE FIGURE 3-14)
2 BAIN.0000 ANALOG INPUT PANEL (8-CHAN) 1
(SEE FIGURE 3-16)
2A BAIN.1600 ANALOG INPUT PANEL CHANNELS 9-16 (8-CHAN) | (1)
(APX586 ONLY) (SEE FIGURE 3-16)
3 BDFP.0000 ADV DIGITAL IO PANEL (SEE FIGURE 3-18) (1)
BSPS.0000 DIGITAL 10 PANEL (SEE FIGURE 3-19) (1)
4 7134.0136 PANEL, BLANK, SMALL (QTY AS NEEDED) (0-4)
BHDM.0000 HDMI I/O PANEL (OPTIONAL) (SEE FIGURE 3-25) | (1)
AND (SEE FIGURE 3-26)
6 BTFP.0000 BLUETOOTH I/0 PANEL (OPTIONAL) (SEE FIGURE | (1)
3-27)
7 BDIO.0000 DIGITAL SERIAL /0O PANEL (OPTIONAL) (SEE FIG- | (1)
URE 3-29)
8 BPDF.0000 PDM I/0 PANEL (OPTIONAL) (SEE FIGURE 3-28) (1)
9 BSLR.0000 ADV MASTER CLOCK REAR PANEL (1)
7134.0150 PLATE, BLANK, REAR (REV 1 CHASSIS) (1)
10 7134.0130 PLATE, BLANK, REAR (REV 0 CHASSIS) 2
11 5112.1108.7 SCREW FLT PH 100 DEG AN 4-40 X 1/4 BLACK 24-28
(REV 1 CHASSIS)
5112.1108.8 SCREW FLT PH 100 DEG AN 4-40 X 1/4 GREY (24-28)
(REV 0 CHASSIS)
12 5112.1108.2 SCREW FLT PH 100 DEG ZN 4-40 X 1/4 6
(REV 1 CHASSIS)
13 5112.3108 SCREW MC SEM PH ZN 4-40 X 1/4 (8)
(REV 0 CHASSIS)

Option quantities are shown in parentheses.
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Figure 3-5 Front and Rear Panels (8-chan)
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Table 3-6: Rack Mount

ITEM PART NO DESCRIPTION QTY
RAK-585 RACK MOUNT, SLIDING (COMPLETE ASSY) 1

1 7171.0001 RACK SLIDE (INCLUDES SCREWS) (SET) 1
7310.0014 BRACKETS (PR) 1
8211.0240 RACK MOUNT INSTRUCTIONS 1
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Figure 3-6 Rack Mount
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Table 3-7: Circuit Boards (top view) (APx525/526)

ITEM PART NO DESCRIPTION QTY
1 BMEG.0000 ANALOG OUTPUT BOARD ASSY (2-CHAN) 1
2 BZOD.0000 CPU BOARD ASSY 1
3 BOTA.0000 ANALOG INPUT BOARD ASSY (2-CHAN) 1
3A BOTA.0000 ANALOG INPUT BOARD ASSY CHANNELS 3&4 (1)
(2-CHAN) (APX521 AND 526 ONLY)
4 BAES.0000 DIGITAL I/O BOARD ASSY (APX525 AND 526 ONLY) |1
5 BSOL.0000 SYSTEM CLOCK BOARD ASSY 1
(SEE BOTTOM VIEW)
6 5113.7108 SCREW MC SEM PH ZN #6-32 X 1/4 49
7 5323.0001 WASHER LOCK #6 22
8 5535.1250 STANDOFF HEX F/F 6-32 X .25 X .5 STL/ZN 22
9 5533.1250 STANDOFF HEX M/F 6-32 X .25 X .5 STL/ZN 4
10 5534.1031 STANDOFF HEX M/F 6-32 X .312 STL/ZN 1
11 5532.1106.1 STANDOFF HEX M/F JACK SCREW 6
12 BSAT.0000 AG52 ANALOG GENERATOR OPTION BOARD ASSY | 1
13 BROT.0000 BW52 HIGH BANDWIDTH OPTION BOARD ASSY 1
14 BRIO.0000 INTERCONNECT BOARD 1
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Figure 3-7 Circuit Boards (top view) (APx525/526)
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Table 3-8: Circuit Boards (bottom view) (APx525/526)

ITEM PART NO DESCRIPTION QTY
1 BMEG.0000 ANALOG OUTPUT BOARD ASSY (2-CHAN) 1
2 BZOD.0000 CPU BOARD ASSY 1
3 BOTA.0000 ANALOG INPUT BOARD ASSY (2-CHAN) 1
3A BOTA.0000 ANALOG INPUT BOARD ASSY CHANNELS 3&4 (1)
(2-CHAN) (APX521 AND 526 ONLY)
4 BAES.0000 DIGITAL I/O BOARD ASSY (APX525 AND 526 ONLY) | (1)
5 BSOL.0000 SYSTEM CLOCK BOARD ASSY 1
6 5113.7108 SCREW MC SEM PH ZN #6-32 X 1/4 49
7 5323.0001 WASHER LOCK #6 22
8 5535.1250 STANDOFF HEX F/F 6-32 X .25 X .5 STL/ZN 22
9 5533.1250 STANDOFF HEX M/F 6-32 X .25 X .5 STL/ZN 4
10 5534.1031 STANDOFF HEX M/F 6-32 X .312 STL/ZN 1
11 5532.1106.1 STANDOFF HEX M/F JACK SCREW 6
(SEE TOP VIEW)
12 BSAT.0000 AG52 ANALOG GENERATOR OPTION BOARD ASSY | 1
13 BROT.0000 BW52 HIGH BANDWIDTH OPTION BOARD ASSY 1
14 BRIO.0000 INTERCONNECT BOARD (SEE TOP VIEW) 1
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Figure 3-8 Circuit Boards (bottom view) (APx525/526)
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Table 3-9: Circuit Boards (top view) (APx555)

ITEM PART NO DESCRIPTION QTY
1 B4A0.0000 ANALOG OUTPUT BOARD ASSY (2-CHAN HP) 1
2 BZOD.0000 CPU BOARD ASSY 1
3 B4AI.0000 ANALOG INPUT BOARD ASSY (2-CHAN HP) 1
4 BADI.0000 DIGITAL I/0 BOARD ASSY 1
5 BSL2.0000 SYSTEM CLOCK BOARD ASSY 1

(SEE BOTTOM VIEW)
5A BSLR.0000 ADVANCED MASTER CLOCK REAR PANELASSY |1

(SEE BOTTOM VIEW)
6 5113.7108 SCREW MC SEM PH ZN #6-32 X 1/4 49
7 5323.0001 WASHER LOCK #6 22
8 5535.1250 STANDOFF HEX F/F 6-32 X .25 X .5 STL/ZN 22
9 5533.1250 STANDOFF HEX M/F 6-32 X .25 X .5 STL/ZN 4
10 5534.1031 STANDOFF HEX M/F 6-32 X .312 STL/ZN 1
1 5532.1106.1 STANDOFF HEX M/F JACK SCREW 6
12 B4SG.0000 ANALOG SINE GENERATOR 1
13 B4BR.0000 ANALOG BAND REJECT FILTER 1
14 BRIO.0000 INTERCONNECT BOARD 1
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Figure 3-9 Circuit Boards (top view) (APx555)
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Table 3-10: Circuit Boards (bottom view) (APx555)

ITEM PART NO DESCRIPTION QTY
1 B4A0.0000 ANALOG OUTPUT BOARD ASSY (2-CHAN HP) 1
2 BZOD.0000 CPU BOARD ASSY 1
3 B4AI.0000 ANALOG INPUT BOARD ASSY (2-CHAN HP) 1
4 BADI.0000 DIGITAL I/0 BOARD ASSY 1
5 BSL2.0000 SYSTEM CLOCK BOARD ASSY 1
5A BSLR.0000 ADVANCED MASTER CLOCK REAR PANELASSY |1
6 5113.7108 SCREW MC SEM PH ZN #6-32 X 1/4 49
7 5323.0001 WASHER LOCK #6 22
8 5535.1250 STANDOFF HEX F/F 6-32 X .25 X .5 STL/ZN 22
9 5533.1250 STANDOFF HEX M/F 6-32 X .25 X .5 STL/ZN 4
10 5534.1031 STANDOFF HEX M/F 6-32 X .312 STL/ZN 1
11 5532.1106.1 STANDOFF HEX M/F JACK SCREW 6
(SEE TOP VIEW)

12 B4SG.0000 ANALOG SINE GENERATOR 1
13 B4BR.0000 ANALOG BAND REJECT FILTER 1
14 BRIO.0000 INTERCONNECT BOARD (SEE TOP VIEW) 1
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Figure 3-10 Circuit Boards (bottom view) (APx555)
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Table 3-11: Circuit Boards (top view) (8-chan)

ITEM PART NO DESCRIPTION QTY
1 BPLX.0000 ANALOG OUTPUT BOARD ASSY (8-CHAN) 1
2 BZOD.0000 CPU BOARD ASSY 1
3 BCAS.0000 ANALOG INPUT BOARD ASSY (8-CHAN) 1
3A BCAS.0000 ANALOG INPUT BOARD ASSY CHANNELS 9-16 (1)
(8-CHAN) (APX586 ONLY)
4 BAES.0000 DIGITAL I/O BOARD ASSY 1
5 BSOL.0000 SYSTEM CLOCK BOARD ASSY 1
(SEE BOTTOM VIEW)
6 5113.7108 SCREW MC SEM PH ZN #6-32 X 1/4 49
7 5323.0001 WASHER LOCK #6 22
8 5535.1250 STANDOFF HEX F/F 6-32 X .25 X .5 STL/ZN 22
9 5533.1250 STANDOFF HEX M/F 6-32 X .25 X .5 STL/ZN 4
10 5534.1031 STANDOFF HEX M/F 6-32 X .312 STL/ZN 1
11 5532.1106.1 STANDOFF HEX M/F JACK SCREW 6
12 BRIO.0000 INTERCONNECT BOARD 1
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Figure 3-11 Circuit Boards (top view) (8-chan)
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Table 3-12: Circuit Boards (bottom view) (8-chan)

ITEM PART NO DESCRIPTION QTY
1 BPLX.0000 ANALOG OUTPUT BOARD ASSY 1
2 BZOD.0000 CPU BOARD ASSY 1
3 BCAS.0000 ANALOG INPUT BOARD ASSY 1
3A BCAS.0000 ANALOG INPUT BOARD ASSY (FOR CHAN 9-16) (1)
(APX586 ONLY)

4 BAES.0000 DIGITAL I/0 BOARD ASSY 1
5 BSOL.0000 SYSTEM CLOCK BOARD ASSY 1
6 5113.7108 SCREW MC SEM PH ZN #6-32 X 1/4 49
7 5323.0001 WASHER LOCK #6 22
8 5535.1250 STANDOFF HEX F/F 6-32 X .25 X .5 STL/ZN 22
9 5533.1250 STANDOFF HEX M/F 6-32 X .25 X .5 STL/ZN 4
10 5534.1031 STANDOFF HEX M/F 6-32 X .312 STL/ZN 1
11 5532.1106.1 STANDOFF HEX M/F JACK SCREW (SEE TOP VIEW) | 6
12 BRIO.0000 INTERCONNECT BOARD (SEE TOP VIEW) 1
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Figure 3-12 Circuit Boards (bottom view) (8-chan)
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Table 3-13: Front Switch Panel

ITEM PART NO DESCRIPTION QTY
BLOG.0000 FRONT SWITCH PANEL (COMPLETE ASSY) 1

1 7320.0025 INSERT, FRONT PANEL 1

2 7320.0028 BUTTON, ON/OFF, FRONT PANEL 1

3 BVIV.0000 BOARD, LED INSERT 1

4 5111.3110.7 SCREW MC PAN PH M/S ZINC #2-56 X 5/16 4

5 5622.0116 DIFFUSER, 20MM X 24 MM, ROSCOLUX #116 1
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Figure 3-13 Front Switch Panel
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Table 3-14: Analog Output Panel (2-chan)

ITEM PART NO DESCRIPTION QTY
BAOU.2000 ANALOG OUTPUT PANEL (2-CHAN) 1
(COMPLETE ASSY)
1 7134.0145 PLATE, ANALOG, OUTPUT 203 (2-CHAN) 1
2 BOFP.0000 FRONT PANEL BOARD ASSY 1
3 4255.0003 JACK, BANANA 4
4 3612.0750 LIGHTPIPE PNL FLAT .750" CLEAR 4
5 4255.0002 JACK, BANANA GROUNDED KNURLED 2
6 4254.0014 JACK, BNC ISOLATED 50 OHM 2
7 5112.7108 SCREW MC SEM PH ZN #4-40X1/4 4
8 5522.1127 STANDOFF HEX THRD 3/16 X .858 4
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Figure 3-14 Analog Output Panel (2-chan)
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Table 3-15: Analog Output Panel (8-chan)

ITEM PART NO DESCRIPTION QTY

BAOU.0000 ANALOG OUTPUT PANEL (8-CHAN) 1
(COMPLETE ASSY)

1 BLED.0000 BOARD, LED D-SUB PANEL MT ASSY 1

2 7134.0143 PLATE, ANALOG OUTPUT 201 (8-CHAN) 1

3 4255.0002 JACK BANANA GNDED KNURLED 1

4 5532.1106.1 STANDOFF, HEX, M/F, JACK SCREW 2

5 4255.0002 NUT PANEL, BR-NKL 1/4-32 X 3/8 X 3/32 2

6 4254.0014 JACK ISOLATED BNC PNL MT 50 OHM FM 8

7 3612.0125 LIGHTPIPE STRT FLAT .125 LONG CLEAR 9
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Figure 3-15 Analog Output Panel (8-chan)
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Table 3-16: Analog Input Panel (2-chan)

ITEM PART NO DESCRIPTION QTY QTY
CHAN 182 | CHAN 384
BAIN.2000 ANALOG INPUT PANEL (2-CHAN) 1
(COMPLETE ASSY)
BAIN.3000 ANALOG INPUT PANEL CHAN 3&4 (2-CHAN) 1
(COMPLETE ASSY)
1 7134.0144 PLATE, ANALOG INPUT 204 (2-CHAN) 1
1 7134.0149 PLATE, ANALOG INPUT 207 (2-CHAN) 1
2 BIFP.0000 FRONT PANEL BOARD ASSY 1 1
3 4255.0003 JACK, BANANA 4 4
4 3612.0750 LIGHTPIPE PNL FLAT .750” CLEAR 4 4
5 4255.0002 JACK, BANANA GROUNDED KNURLED 2 2
6 4254.0014 JACK, BNC ISOLATED 50 OHM 2 2
7 5112.7108 SCREW MC SEM PH ZN #4-40X1/4 4 4
8 55622.1127 STANDOFF HEX THRD 3/16 X .858 4 4
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Figure 3-16 Analog Input Panel (2-chan)
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Table 3-17: Analog Input Panel (8-chan)

ITEM PART NO DESCRIPTION QTY QTY
CHAN 1-8 | CHAN 9-16
BAIN.0000 ANALOG INPUT PANEL (8-CHAN) 1
(COMPLETE ASSY)
BAIN.1600 ANALOG INPUT PANEL CHAN 9-16 (8-CHAN) 1
(COMPLETE ASSY)
1 BLED.0000 BOARD, LED D-SUB PANEL MT ASSY 1 1
2 7134.0142 PLATE, ANALOG INPUT 205 (8-CHAN) 1
2 7134.0140 PLATE, ANALOG INPUT 206 (8-CHAN) 1
3 4255.0002 JACK BANANA GNDED KNURLED 1 1
4 5532.1106.1 STANDOFF, HEX, M/F, JACK SCREW 2 2
5 4255.0002 NUT PANEL, BR-NKL 1/4-32 X 3/8 X 3/32 2 2
6 4254.0014 JACK ISOLATED BNC PNL MT 50 OHM FM 8 8
7 3612.0125 LIGHTPIPE STRT FLAT .125 LONG CLEAR 9 9
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Figure 3-17 Analog Input Panel (8-chan)

APx500 Series Service Manual 3-35



Section 3: Mechanical Diagrams

Table 3-18: Advanced Digital /0 Panel

ITEM PART NO DESCRIPTION QTY
BDFP.0000 ADV DIGITAL I/0 PANEL (COMPLETE ASSY) 1

1 BDIF.0000 BOARD, DIGITAL I/O CONNECTORS 1

2 7134.0172 PLATE, ADIO 219 1

3 4254.0001 JACK BNC PNL MT W/HDWR GNDED 2

4 5112.1108.7 SCREW FLT PH SS BLK ZN 4-40 X 1/4 2

5 5222.0001 NUT KEP 4-40 4

6 3612.2820 LIGHTPIPE RT ANG 2
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2X

2X

Figure 3-18 Advanced Digital I/O Panel
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Table 3-19: Digital /0 Panel (Single wide)

ITEM PART NO DESCRIPTION QTY
BSPS.0000 DIGITAL I/0 PANEL (COMPLETE ASSY) 1

1 BSFP.0000 BOARD, DIGITAL I/O CONNECTORS 1

2 7134.0178 PLATE, DIO 227 1

3 4254.0001 JACK BNC PNL MT W/HDWR GNDED 2

4 5112.1108.7 SCREW FLT PH SS BLK ZN 4-40 X 1/4 2

5 5222.0001 NUT KEP 4-40 4

6 3612.2820 LIGHTPIPE RT ANG 2
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Figure 3-19 Digital I/O Panel (Single wide)
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Table 3-20: Digital 1/0 Panel

ITEM PART NO DESCRIPTION QTY
BSOP.0000 DIGITAL I/0 PANEL (COMPLETE ASSY) 1

1 BAFP.0000 BOARD, DIGITAL I/O CONNECTORS 1

2 7134.0147 PLATE, AESOP 110 1

3 4254.0001 JACK BNC PNL MT W/HDWR GNDED 2

4 5112.1108.8 SCREW FLT PH 100DEG ZN 4-40 X 1/4 2

5 5222.0001 NUT KEP 4-40 4

6 3612.0055 LIGHTPIPE 5.5” FLEX W/4AMM LENS CAP 2
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Figure 3-20 Digital I/O Panel
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Table 3-21: Digital /0 Panel (unbalanced only, early units)

ITEM PART NO DESCRIPTION QTY
BDIG.0000 DIGITAL I/0O PANEL (COMPLETE ASSY) (OBS NLA) |1

1 BCIF.0000 BOARD, DIGITAL I/O 1

2 7134.0139 PANEL, INTERFACE, DIGITAL MOD 109 1

3 7310.0039 BRACKET, SUPPORT 2

4 5112.1108.8 SCREW FLT PH 100DEG ZN 4-40 X 1/4 2

5 5113.7108 SCREW MC SEM PH ZN #6-32 X 1/4 2
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Figure 3-21 Digital I/O Panel (unbalanced only, early units)
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Table 3-22: Digital /0 w/Digital Serial 1/0 Panel

ITEM PART NO DESCRIPTION QTY

BSIR.0000 DIGITAL /O WITH DIGITAL SERIAL I/O PANEL 1
(COMPLETE ASSY)

1 BAFP.0000 BOARD, DIGITAL /O CONNECTORS 1

7124.0146 PLATE, DIGITAL I/O WITH DIGITAL SERIALI/O | 1
111

3 4254.0001 JACK BNC PNL MT W/HDWR GNDED 2

4 5112.1108.8 SCREW FLT PH 100DEG ZN 4-40 X 1/4 2

5 5222.0001 NUT KEP 4-40 4

6 3612.0055 LIGHTPIPE 5.5” FLEX W/4MM LENS CAP 2

7 5532.1106.1 STANDOFF, HEX, M/F, JACK SCREW 8

8 BDSA.0000 BOARD, DIGITAL SERIAL /O 1

9 BMPA.0000 BOARD, DIGITAL SERIAL 1/O MONITOR 1
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Figure 3-22 Digital /0 with Digital Serial 1/0 Panel
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Table 3-23: Digital /0 w/Bluetooth Panel

ITEM PART NO DESCRIPTION QTY
BDIO.BT DIGITAL I/0 W/BLUETOOTH PANEL 1
(COMPLETE ASSY)
1 3600.0000 ADAPTER FLEX LIGHT PIPE 2
2 3612.0055 LIGHTPIPE 5.5” FLEX 2
3 3612.0125 LIGHTPIPE STRT .125 CLR 2
4 4151.7002 CABLE ASSY 7” 2 COND 2
5 4251.0003 ADAPTER N TO SMA 1
6 NUT INCLUDED WITH #5 2
7 LOCKWASHER INCLUDED WITH #5 2
8 4253.0011 XLR M (SHELL ONLY; CONNECTOR ON BAFP.0000) | 1
9 4253.0012 XLR F (SHELL ONLY; CONNECTOR ON BAFP.0000) |1
10 4254.0001 JACK BNC PNL MT 2
11 NUT INCLUDED WITH #10 2
12 5112.1108.7 SCREW FH BLK 4-40X1/4 2
13 5112.7108 SCREW MC PH ZN 4-40X4/4 2
14 5222.0001 NUT KEP #4-40 4
15 5417.0001 LUG SOLDER 3/8 IN 2
16 7134.0168 DIO W/BT PANEL 1
17 BAFP.0000 BAL/UNBAL DIG I/O PANEL PCB ASSY 1
18 BZFP.0000 AZUL FP PCB ASSY 1
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Figure 3-23 Digital 1/0 with Bluetooth
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Table 3-24: Digital /0 w/PDM Panel

ITEM PART NO DESCRIPTION QTY
BDIO.PDM DIGITAL I/0 W/PDM PANEL (COMPLETE ASSY) 1
1 3600.0000 ADAPTER FLEX LIGHT PIPE 2
2 3612.0000 LIGHTPIPE .5 LG CLR 5
3 3612.0055 LIGHTPIPE 5.5” FLEX 2
4 4151.7002 CABLE ASSY 7”2 COND 2
5 4253.0011 XLR M (SHELL ONLY; CONNECTOR ON BAFP.0000) |1
6 4253.0012 XLR F (SHELL ONLY; CONNECTOR ON BAFP.0000) |1
7 4254.0001 JACK BNC PNL MT 2
8 NUT INCLUDED WITH #7 2
9 5112.1108.7 SCREW FH BLK 4-40X1/4 2
10 5222.0001 NUT KEP #4-40 4
1 5241.0001 NUT JAM 10
12 5325.0002 WASHER LOCK 5
13 5417.0001 LUG SOLDER 3/8 IN 2
14 7134.0169 DIO-PDM PANEL 1
15 BAFP.0000 DIO PANEL PCB ASSY 1
16 BPFP.0000 PDM PANEL PCB ASSY 1
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Figure 3-24 Digital I/O with PDM Panel
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Table 3-25: HDMI Panel (Type M)

ITEM PART NO DESCRIPTION QTY
BHDM.0000 HDMI FRONT PANEL (COMPLETE ASSY) 1

1 BVID.0000 HDMI BOARD ASSEMBLY 1

2 7134.0160 PANEL, HDMI I/F 112 1

3 5112.1108.8 SCREW FLT PH 100DEG ZN4-40 X 1/4 4

4 5222.0001 NUT KEP 4-40 4
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Figure 3-25 HDMI Panel (Type M)
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Table 3-26: HDMI Panel (Type E)

ITEM PART NO DESCRIPTION QTY
BHDM.0000 HDMI FRONT PANEL (COMPLETE ASSY) 1

1 3612.1000 LIGHTPIPE RT ANG FLAT FACE CLEAR 4

2 5112.1110.8 SCREW PHSTL 100DEG BLK FHS4-40X5/16 4

3 7134.0179 ERNI CONN PNL VID/HDMI I/F MOD 226 1

4 BVID.0000 ERNI HDMI ARC BOARD ASSEMBLY 1
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Figure 3-26 HDMI Panel (Type E)
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Table 3-27: Bluetooth Panel

ITEM PART NO DESCRIPTION QTY
BTFP.0000 BLUETOOTH FRONT PANEL (COMPLETE ASSY) 1

1 3612.0125 LIGHTPIPE STRT .125 CLR 2

2 LOCKWASHER INCLUDED WITH #3 2

3 4255.0004 JACK TYPE N BULKHEAD TO U.FL/AMC 1

4 NUT INCLUDED WITH #3 2

5 5113.7108 SCREW MC SEM PH ZN #6-32X1/4 2

6 7134.0161 CONN PNL BLUE TOOTH I/F MODEL 213 1

7 BZFP.0000 AZUL FP ECB ASSY 1

3-54 APx500 Series Service Manual



| Diagrams

Section 3: Mechanica

Figure 3-27 Bluetooth Panel
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Table 3-28: PDM Panel

ITEM PART NO DESCRIPTION QTY
BPDF.0000 PDM FRONT PANEL (COMPLETE ASSY) 1

1 3612.0000 LIGHTPIPE .5 LG CLEAR 5

2 5241.0001 NUT JAM 10

3 5325.0002 WASHER LOCK 5

4 7134.0166 CONN PANEL PDM 228 1

5 BPFP.0000 APX PDM FR PANEL ASSY 1
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Figure 3-28 PDM Panel
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Table 3-29: Digital Serial /0 Panel

ITEM PART NO DESCRIPTION QTY
BDIO.0000 DSIO FRONT PANEL (COMPLETE ASSY) 1

1 55632.1106 HEX M/F JACK SCREW 8

2 7134.0167 CONN PANEL DSIO SINGLE MODEL 216 1

3 BDSA.0000 DIGIT SERIAL PCB ASSY 1

4 BMPA.0000 MONITOR PANEL PCB ASSY 1
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Figure 3-29 Digital Serial I/O Panel
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Section 4: Adjustments

4.1 Introduction

Adjustment is the process of changing or
resetting various hardware and/or software
elements to compensate for the inevitable effects
of component tolerances and drift.

Audio Precision recommends following a
periodic adjustment schedule to insure optimum
instrument performance. Once every 24 months is
generally sufficient if the unit is operated under
controlled environmental conditions between
+15° C and +30° C (+59° F and +86° F). This
interval should be reduced to once every 12
months if the unit is operated under
environmental extremes and/or exposed to
mechanical vibration or condensing humidity.

Adjustment should always be performed
following any major repair or module
replacement.

The APx Self Test should be run, both before and
after an adjustment, to check all major aspects of
the instrument’s performance against published
specifications. Instructions for running the Self
Test are in Section 5.

4.2 Physical Preparation

Unplug the AC power cord and remove both the
top and bottom instrument covers. Remove
jumper P212, located on the BRIO module just to
the left of the left-side fan, and set it aside.

Position the unit as needed to gain access to the
module being adjusted. Reconnect the ac power
cord and turn the power switch on. Be sure the

power line voltage is between 100 and 240 Vac.

If adjustment is taking place following a repair or
module replacement, be sure that all mounting
hardware and interconnection cables have been
replaced, and that all cables are positioned
exactly as they were previously. Many of the
modules depend upon grounding paths through
the mounting screws for proper operation.

4.3 Adjustment Location Diagrams
Diagrams of adjustment and test point locations
start on page 4-5. The points are also shown in
each screen prompt of the corresponding APx
adjustment project. The locations of the modules
in the instrument are shown in Section 3. Page
7-1 provides help in identifying module revisions.

4.4 Test Points

Test points are either small square copper circuit
board pads, or red stand-up eye loops. Unless
otherwise noted, any convenient chassis point
may be used as ground reference for all voltage
and signal measurements.

4.5 Environmental Range

Adjustments should be performed only between
+20° C and +25° C (+68° F and +77° F). After
powering on the instrument, allow at least 60
minutes for circuit stabilization before
proceeding with any adjustments.

4.6 Required Test Equipment and Cables
The following equipment is required to adjust the
APx instrument. Minimum performance

APx500 Series Service Manual
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Section 4: Adjustments

characteristics and suggested models are listed CAB-582: (for APx582)
below: AP PIN QTY | Description
. . Fluke 8845A or
Multimeter: Agilent 34401A 4150.0003 1 DB25 to XLR-F Cable
7 digits, +0.2 ppm 4155.0301 3 BNC to BNC Cable 14"
Counter: Agilent 53131A with opt 010 4155.0117 25 XLR AES/EBU Cable 1M
timebase
4151.0303 5 TOSLINK Optical Cabl
Oscilloscope: Tektronix TDS3052B °1.0 ! © Optical Cable
4251.0101 1056 BNC to RCA Adapters
A number of cables are needed to perform the 4155.0525 15.6 Ground Strap
adjustments. You may supply your own cables, or
obtain most of them from Audio Precision by CAB-585 | CAB-586 (for APx585 / APx586):

ordering the SVC-KITO005 service kit, as well as

the appropriate instrument-specific kit below. The AP PIN Qry Description
complete list of cables and cable kits available 4150.0001 15 DB25 to DB25 Cable
from AP'1s online at www:ap.com/product§/ 4150.0002 1 DB25 to XLR-M Cable
accessories/cables. You will also need the items 3
listed under “Additional Cables/Adapters”. 4150.0003 ) 1 DB25 to XLR-F Cable
4155.0301 11 BNC to BNC Cable 14"
CAB-520 / CAB-521: 4155.0117 25 XLR AES/EBU Cable 1M
(for APx520, 525, or 555 without Digital 10 / APx521 or 4151.0303 45 TOSLINK Optical Cable

526 without Digital 10)

4251.0101 18456 BNC to RCA Adapters

AP P/N QTY Description
4155.0525 156 Ground Strap
4155.010x" 42 XLR-M to XLR-F Cable 8'
4155.0039 4 BNC to BNC Cable 1M SVC-KIT005:
56
4155.0525 1 Ground Strap AP PIN aTY Description
CAB-525 /| CAB-526: (for APx525 or APx555 | APx526) 4151.FADJA | 1 XLR-F to Banana Cable
T DB25 to BNC Common
AP P/N QTY Description 4151.CMAA | 1 Mode Fixture
4155.010x" 42 XLR-M to XLR-F Cable 8'
4155.0039 4 BNC to BNC Cable 1M ADDITIONAL CABLES/ADAPTERS:
4155.0117 25 XLR AES/EBU Cable 1M AP PIN QTY Description
4151.0303 | 15 TOSLINK Optical Cable 41550039 | 1 BNC to BNC Cable 1M
o6 BNC-M to Dual Banana
4155.0525 1° Ground Strap n/a 1 Adapter7 (Pomona 1269 or
equivalent)
Notes:
1. x= 2-Red, 4-Yellow, 5-Green, 6-Blue, (7-Black, 8-
White).
2. CAB-521/526 quantity=6.
3. CAB-586 quantity=2.
4. CAB-586 quantity=26.
5. Not used for adjustments.
6. Not used for Self Test.
7. Not available from Audio Precision.

4-2 APx500 Series Service Manual



Section 4: Adjustments

Caution: Perform adjustments in an
ESD-protected (electrostatic
discharge protected) work area,
while observing all ESD handling
requirements as described in ANSI/
ESD S20.20-1999. As a minimum,

use a grounded anti-static work mat
and wrist strap.

4.7 Installing the Service Package Files
APx500 measurement software must already be
installed before copying the files provided in this
download. The adjustment projects require the
specific version of APx500 measurement
software indicated in the Readme.txt file of the
download. The APx500 software may be
downloaded from ap.com. If this version is
different than the version you are currently
running, it may be installed concurrently in a
separate directory.

Copy the \Addins folder to \Program Files
(x86)\Audio Precision\APx500 x.x\Addins. Copy the
\Service folder to a convenient location, such as
\My Documents\Audio Precision\APx500 x.x\Service.
In both cases, x.x represents the version of
APx500 that is required.

4.8 Running the Adjustment Project

Run APx-Adjust.exe, located in the
\Service\Adjustments folder. This will load the
correct APx adjustment project (except for the
APx555 model; see below for more detail). This
will enable the correct signal paths for the
connected instrument. To start the adjustment
sequence, click the green arrow or choose
Project > Run Sequence. Follow the on-screen
prompts. Modules that are not included in the
adjustment project do not require adjustment.

For the APx555 models the APx-Adjust.exe is
not used. During the adjustment process for both
the output and input adjustments the B4SG and
B4BR modules will need to be removed to gain

access to the adjustment locations on the B4AO
and B4AI modules. Each adjustment project for
the APx555 is run as a separate project.

To adjust the B4AO module turn off the power to
the instrument and remove the B4SG module and
set it aside. Turn the instrument on and open the
control software. Click on the File button on the
control bar and then click on the Open Project
button and load the 555-Adjust-AO project.
Click the green arrow or choose Project > Run
Sequence. After the B4AO module is adjusted
the instrument is turned off and the B4SG module
is reinstalled. After the power is restored and the
control software is opened the 555-Adjust-SG
adjustment project is loaded and then run.

To adjust the B4AI module turn off the power to
the instrument and remove the B4BR module and
set it aside. Turn the instrument on and open the
control software. Click on the File button on the
control bar and then click on the Open Project
button and load the 555-Adjust-Al project. Click
the green arrow or choose Project > Run
Sequence. After the B4AI module is adjusted the
instrument is turned off and the B4BR module is
reinstalled. After the power is restored and the
control software is opened the 555-Adjust-BR
adjustment project is loaded and then run.

4.9 Setting A/D Constants

After completing the adjustment project, set the
A/D converter constants by going to Tools >
Service > Analog Input Adjustment in the APx500
software. Connect the Analog Outputs to the
Analog Inputs with short BNC cables when
prompted.

4.10 Module Adjustment Date

After setting the A/D, go to Tools > Service >
Module Adjustment. In the form, enter your initials,
mark the check boxes for the modules that you
have adjusted, check that the date is set correctly,
and click Save. This information will be saved to
the EEPROM on each module.

APx500 Series Service Manual
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4.11 Jumper Replacement

After completing the adjustments, exit the
APx500 software and turn off the instrument.
Replace jumper J212 and reattach the covers.

4.12 5 Volt Power Supply Adjustment

If it is determined from the power supply checks
in the adjustment procedure that the +5 Vdc
supply needs adjustment, follow the steps below
to access the trimmer and set it to +5.0 + 0.1 Vdc.
Once it is trimmed, restart the adjustment project
sequence from the beginning.

Required tool:

GC Electronics #8988 Long Reach Insulated
Screwdriver or equivalent (1/8" x 12" long shaft,
plastic or heat shrink insulated metal).

1) Turn off the unit and remove the power cord.
2) Locate the power switch on the power supply.

| Coupler

3a) (Chassis rev 0)With pliers, unsnap the coupler
that attaches the actuator rod to the switch.

When Service is Completed
Inspect the unit to ensure that the unit is in its original configuration - inspect and confirm that the
safety ground wire (green with a yellow stripe) between the AC Mains coupler and the chassis ground
post is securely attached at the coupler and the chassis post. Confirm that the fuses are the correct type
and value as marked on the rear of the chassis. Perform a complete visual inspection to confirm that all
assemblies are secured and properly seated and that all wire assemblies are not pinched or otherwise
mis-routed.

3b) (Chassis rev 1) Cut off the heat shrink that
fixes the actuator bar to the switch.

®
& :

3

4) Remove the seven screws on the back of the
power supply that attach it to the chassis.

5) Reattach the power cord and turn the unit on.

6) Pull out the power supply slightly and tilt it up,
so that the adjustment hole is visible. Insert the
GC #8988 long reach insulated screwdriver
underneath the circuit board and adjust the power
supply for +5.0 + 0.1 Vdc, measured at test points
+5V:A, +5V:B, and +5V:C on the BRIO module.

7) Re-attach the power supply.
8a) (Chassis rev 0) Reattach the coupler that
attaches the actuator rod to the switch.

8b) (Chassis rev 1) Replace and shrink the heat
shrink sleeve that fixes the actuator bar to the
switch.

4-4
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Section 5: Self Test

5.1 Introduction

The APx500 Series Service Package includes the
APx Self Test, which checks all major aspects of
the instrument’s performance against published
specifications. Running Self Test periodically is a
good way to verify that the instrument is
performing as expected. It is also a valuable aid to
help determine if an observed problem is internal
or external to the instrument. Before calling for
service, run Self Test to help us pinpoint the
problem area and recommend a course of action.

Self Test is not a substitute for calibration.
Calibration is a higher level of verification that
compares the instrument’s performance to highly
accurate lab test equipment. Calibration can only
be performed at the AP factory or at selected
international distributors.

5.2 Required Cables

The cables needed to run the Self Test provide an
external loopback path from the generator to the
analyzer for each type of analog and digital
connection. You may provide your own cables, or
may order from among the instrument-specific
cable kits listed in Section 4. In addition to the
listed kits, an HDMI cable will be necessary
when testing instruments with HDMI.

CAB-HDMI (for APx585 with HDMI option):

AP P/N QTY Description

4112.0002 | 41 HDMI to HDMI Cable

1. Only one cable is needed for the Self Test.

5.3 Installing the Service Package Files
APx500 measurement software must already be
installed before copying the files provided in this
download. The adjustment projects require the
specific version of APx500 measurement

software indicated in the Readme.txt file of the
download. The APx500 software may be
downloaded from ap.com. If this version is
different than the version you are currently
running, it may be installed concurrently in a
separate directory.

Copy the \Addins folder to \Program Files
(x86)\Audio Precision\APx500 x.x\Addins. Copy the
\Service folder to a convenient location, such as
\My Documents\Audio Precision\APx500 x.x\Service.
In both cases, x.x represents the version of
APx500 that is required.

5.4 Running Self Test

We recommend that you check the Downloads
section of AP.com for the latest version of Self
Test and update the files as necessary.

Instructions for running Self Test are provided in
the \Service\SelfTest folder.

Turn on the instrument and allow it to warm up
and stabilize for 30 minutes before starting Self
Test.

5.5 Self Test Reports

Once started, except for prompts to attach cables,
Self Test will run automatically and generate an
on-screen report when it is done. The top of the
report will show an overall Pass or Fail result, and
then each section of the report will show a series
of measurement results, followed by an indication
of pass (in green) or fail (in orange). If any test
fails, verify that the cables are correctly
connected and rerun the test. If the test still fails,
contact AP or your local international distributor
for additional assistance. We recommend that you
save the report and rename the file to include the
instrument serial number and test date. In this
way, you will be able to compare prior and
current results, and will be able to send the report

APx500 Series Service Manual
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to AP if requested by our technical support
department.
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Section 6: Maintenance and Repair

6.1 Introduction

This section and the sections that follow provide
basic information for the maintenance and repair
of the instrument. The field repair of any APx500
Series circuit board assembly or module is NOT
authorized except under very special
circumstances, under the direction of the Audio
Precision factory.

6.2 Cleaning

Audio Precision recommends that its
measurement instruments be cleaned and
examined at least once every two years for
internal dust accumulation. Exposure to harsh or
severe operating environments may dictate more
frequent cleaning. Dust buildup interferes with
the ability of many components to cool properly.
In extreme cases dust can also create conductive
paths that may adversely affect electrical
performance.

Remove accumulated dust on the exterior with a
soft cloth or small brush. A mild detergent may
be used to remove remaining dirt or stains. Do not
use strong or abrasive cleaners. Wipe all surfaces
clean with a damp cloth. Connectors can be
cleaned with a cotton swab or soft cloth
dampened in isopropyl alcohol or water. Digital
signal connectors should be inspected for
damaged pins.

Remove accumulated interior dust with clean,
dry, low pressure air or a static free vacuum. A
soft, dry brush may be required to loosen particles
that resist removal. Always use good static
control procedures when handling or cleaning
circuit assemblies to avoid component damage.

Also examine the cooling fan for dust
accumulation on the leading edge of the blades.
Dust build-up can unbalance the fan and increase
acoustic noise. Clean the blades with a cotton
swab dampened in isopropyl alcohol or water.

6.3 Module Locations

Drawings showing module and hardware
locations are in Section 3. Most repairs are
accomplished by sending defective modules to
the factory or regional service center for repair or
exchange, after contacting AP technical support.

6.4 Soldering Technique

Component level repair should only be performed
under the direction of the Audio Precision
factory. Most components are surface mounted,
and require specialized solder tips or hot air tools
for proper removal and replacement. All flux
residue must be removed from the boards after
soldering.

da

Caution: Perform all hardware removal and installation procedures in an
ESD-protected (electrostatic discharge protected) work area, while observing
all ESD handling requirements as described in ANSI/ESD S20.20-1999. As a
minimum, use a grounded anti-static work mat and wrist strap.

O

Important: Disconnect all power cables and external cable assemblies from the
instrument before starting the hardware removal or installation procedures.

APx500 Series Service Manual
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Section 7: Component Locations

7.1 Introduction

This section contains printed circuit board (PCB)
drawings showing the locations of components,
cable connectors, and adjustment points. Note
that some boards have multiple versions due to
revisions for periodic improvements. All
information is believed to be accurate as of the
publication date; however, Audio Precision
reserves the right to make changes without prior
notice.

7.2 Identifying PCB Revisions

Each printed circuit board has a tag that identifies
the three-digit revision level. In the example
below, the revision level of the BZOD PCB is
201. The major revision is indicated by the first of
the three digits, and is noted on the diagrams that
follow. In the example below, the major revision
level is 2.

Major revision level

y
BZOD-24387-201-7189

Audio
precision

You can also determine the version number of
individual boards in your unit by going to Help >
About in the APx500 measurement software.

o amson X
Biiaessc.. Audio
precision
Audio Precision APx500
® 2006 Audio Precision Inc. Al rights reserved. Copy to Clipboard I
Product Components:
Calibration Date _‘.]

Processor Board

Main Interconnect Board

Clock Module

§-Channel Analog Input Module

8-Channel Analog Output Module
Digital Interface Board ¥

ConporerDesls 4 — Revision level

ID: BPLX-0500¢-003 -
Fw: V3.6

Manufacture Date: 4/3/2008
Adjust Date: 4/3/2006
Factory Adjust: Yes
TechlD: SLR
=

In the example above, the three-digit revision

level of the BPLX board is 009, and the major
revision level is 0.

Revision levels are indicated in the following

drawings by the abbreviation “Rev n”.
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Section 7: Component Locations

Component and Assembly Designators

A | Assembly L Inductor
BT | Battery P Connector, male

C Capacitor, fixed or variable Q Transistor, FET, or SCR
D Diode R | Resistor, fixed or variable
E Socket or mechanical part S Switch or contact

F Fuse TP | Test point

H Heat sink or mounting hardware U Integrated circuit
HS | Heat sink or mounting hardware w Wire strap or cable

J Connector, female X Transformer

K Relay Y Crystal

7-2
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Figure 7-26 BAES Digital /0 Main Module w/XLR (top) Rev 2
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Figure 7-27 BAES Digital I/0 Main Module w/XLR (bottom) Rev 2
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Figure 7-35 BCAS Analog Input Module (8-chan) (top) Rev 1
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Figure 7-36 BCAS Analog Input Module (8-chan) (bottom) Rev 1
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Figure 7-63 BMEG Analog Output Module (2-chan) (bottom) Rev 1
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Figure 7-65 BMEG Analog Output Module (2-chan) (bottom) Rev 2
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Figure 7-67 BMEG Analog Output Module (2-chan) (bottom) Rev 3
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Figure 7-69 BOFP Analog Output Front Panel Module (2-chan) (top) Rev 0
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Figure 7-72 BOTA Analog Input Module (2-chan) (bottom) Rev 0
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Figure 7-74 BOTA Analog Input Module (2-chan) (bottom) Rev 1
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Figure 7-76 BOTA Analog Input Module (2-chan) (bot) Rev 2
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Figure 7-112 BROT BW52 Ultra-high Bandwidth Option Module (bottom) Rev 0
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Figure 7-136 BSWZ Digital Serial I/0 Connector Module (bottom) Rev 0
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Figure 7-146 BVIV Power LED Front Panel Module (bottom) Rev 0
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Figure 7-148 BVIV Power LED Front Panel Module (bottom) Rev 1
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Figure 7-150 BVIV Power LED Front Panel Module (bottom) Rev 2
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Figure 7-151 BVIV Power LED Front Panel Module (top) Rev 3
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Figure 7-152 BVIV Power LED Front Panel Module (bottom) Rev 3
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Figure 7-153 BZFP Bluetooth Front Panel Module (top) Rev 0
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Figure 7-154 BZFP Bluetooth Front Panel Module (bottom) Rev 0
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BRIO DISTRIBUTION MODULE
stz'}
BMEG 2-CHANNEL BOTA 2-CHANNEL
ANALOG OUTPUT MODULE ANALOG OUTPUT MODULE
P903
v
]
P891
P101 P102 P103 P201 P202 P203 P1401P1402 P1403 Y P2401 P2402 P2403
Ed Ed E3 Ed B4 B3 Ed Ed Ed =3 Ed Ed
g J J
.

BOFP BIFP
— 1|

Interconnect Cables (2-chan)

ITEM PART NO DESCRIPTION QTY
1 4151.1003 CABLE ASSY RIBBON 3" 10-COND 2
2 4132.0135 CABLE ASSY SHLD 13.5" 3-PIN 2
3 4151.1014 CABLE ASSY RIBBON 14" 10-COND 1

Figure 7-163 Board Cable Interconnections (2-chan)
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BRIO DISTRIBUTION MODULE

BPLX 8-CHANNEL
ANALOG OUTPUT MODULE

P1ooo’ﬁ

P262 |

P1116 ’[]E

BCAS 8-CHANNEL
ANALOG INPUT MODULE

BLED o BLED 9
J20
Interconnect Cables (8-chan)
ITEM PART NO DESCRIPTION QTY
1 4151.1011 CABLE ASSY RIBBON 11" 10-COND 2
2 4151.1014 CABLE ASSY RIBBON 14" 10-COND 1

Figure 7-164 Board Cable Interconnections (8-chan)
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Section 8: APx515

8.1 Introduction

This section only covers details exclusive to the
APx515 analyzer. For general servicing guidance,
please refer to the main sections of this service
manual.

8.2 Functional Modules

8.2.1 BXAN Main Module

Contains the analog and digital I/O, DSP, system
clock, and all other circuitry except for the CPU
and USB interface.

8.2.2 BZOD CPU / USB Module

Contains the CPU and the USB interface that
carries communications between the APx
instrument and the PC running the APx500
measurement software.

8.3 Mechanical Diagrams
See pages 8-5 — 8-7.

8.4 Adjustments

Use the CAB-525 cable set (see the chart in
Section 4.6) or equivalent. See page 8-9 in this
section for adjustment and test point locations.
See Section 4 for general adjustment information
and for instructions on installing and running the
Adjustment project.

8.5 Self Test

Refer to Section 5 for instructions on installing
and running the Self Test.

8.6 Maintenance and Repair

8.6.1 Disassembly/Reassembly

Tools Needed:

#2 Phillips screwdriver
Medium flat blade screwdriver
Small flat blade screwdriver

Caution: Perform disassembly and
assembly in an ESD-protected

g (electrostatic discharge protected)
work area, while observing all ESD
handling requirements as described
in ANSI/ESD S20.20-1999. As a

minimum, use a grounded
anti-static work mat and wrist strap.

1) Disconnect the AC mains cord from the
instrument.

2) Using a #2 Phillips screwdriver, remove the
eleven 6-32 x 1/4" black screws that secure the
top cover to the APx515 instrument.

i

it 1] ] |

3) Using a #1 Philips screwdriver, remove the
three 4-40 x 1/4" black screws that secure the top
cover to the APx515 front panel. The top cover
can now be removed and set aside in a safe place.

APx500 Series Service Manual
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Section 8: APx515

4) Remove the APx Software Option Key module
by unscrewing the two thumb screws that secure
it to the APx515 rear panel. If the thumb screws
are too tight, a flat blade screw driver will need to
be used to remove the thumb screws. The module
is mated to the APx515 rear panel by a 9-pin
D-sub connector. Gently pull the module to
disconnect it, and set it in a safe place.

5) Using a 3/16" socket driver, unscrew the six
3/16" jack screws that secure the three 9-pin
D-sub connectors to the rear panel.

Removing the BZOD Module

6) Using a #2 Philips screwdriver, remove the
five 6-32 by 1/4" screws that secure the BZOD
module to the chassis.

. i
L e ) [ " e
~ T

7) With your fingers, gently pry up the BZOD
module where it plugs into the BXAN module to
disconnect it. Lift the BZOD module out of the
chassis and set the module aside on an ESD safe
surface.

Removing the BXAN Module

8) Unlock the XLLR connector bodies from the
connector shells by inserting a small flat blade
screwdriver into the slot in each XLLR connector
and turning counter clockwise.

8-2
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ANALOG INPUTS -» DIGITAL 1/Q

EHANNEL 1 ,/o\ CHANNEL 2
N e/
==
UNB v

9) Using a #1 Phillips screwdriver, remove the
two 4-40 x 1/4" screws that secure the AES
Digital Optical Out and Optical In connectors to
the APx515 front panel.

10) Using your fingers, gently disconnect the
plugs that attach to the front panel BNC
connectors to the BXAN module.

11) Disconnect the power transformer and fan
connector from the BXAN module.

12) Using a #2 Philips screwdriver, remove the
ten 6-32 x 1/4" screws that secure the BXAN
module to the APx515 chassis.

13) Slide the BXAN module towards the rear of
the chassis until the XLR connector bodies are
clear of the connector shells. Lift out the BXAN
module and set it in on an ESD safe surface.

APx515 Reassembly

1) Slide the BXAN module into the six XLR
connector shells.

2) Lock the XLR connector bodies to the
connector shells by inserting a small flat blade
screwdriver into the slot in each XLLR connector
and turning clockwise.

3) Using a #1 Philips screwdriver, reinstall the
two 4-40 x 1/4" screws that secure the AES
digital optical out and optical in connectors to the
front panel.

4) Using a #2 Philips screwdriver, reinstall the ten
6-32 x 1/4" screws that secure the BXAN module
to the chassis.

APx500 Series Service Manual
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5) Reconnect the power transformer and fan
connectors to the BXAN Module. The connectors
are polarized to prevent improper insertion.

6) Reconnect the six plugs that attach to the front
panel BNC connectors to the BXAN module. The
BNC connectors are polarized to prevent
improper connection.

7) Place the BZOD module into the chassis so
that it mates with the BXAN module. Gently
press down with your fingers to fully seat the
connectors.

8) Using a 3/16" socket driver, reinstall the six
3/16" jack screws that secure the three 9-pin
D-sub connectors to the rear panel.

9) Using a #2 Philips screwdriver, reinstall the
five 6-32 by 1/4" screws that secure the BZOD
module to the chassis.

10) Reinstall the APx Software Option Key
module by mating the 9-pin connectors and
tighten the two thumbscrews.

Power Supply Checks

With the top cover removed, apply AC mains
power and turn on the power switch. Use a DC
voltmeter with the negative lead connected to the
chassis to check that the rail voltages are correct
according to the following chart. The test points
are on the BXAN module near the power
transformer shield. Voltages can be measured
with or without the BZOD module installed.

Voltage Rails
Test Point Volts DC Value
+1.2VDC +1.1 to +1.3
+2.5VDC +2.4to +2.6
+3.3VDC +3.2to +3.4
+5 VDC (LIN) +4.9 to +5.1
+5VDC +4.9 to +5.1
+16 VDC +15.9 to +16.2
-16 VDC -15.9 to -16.2

Start-up Checks

With the top cover removed, apply AC mains
power and turn on the power switch. Observe that
the three LEDs on the BZOD module are lit, and
that the LED on the BXAN module is flashing at
a slow rate.

8.7 Component Locations

For the BXAN module, see pages 8-11 — 8-14.
For the BZOD module, see Section 7. The
APx515 shares BZOD modules Rev 2 and later
with other APx500 Series models.
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Table 8-1: Chassis

Item Part NO. Description Quan
1 5112.1108.7 SCREW FH PH SS BLK ZN TAPT 4-40 X 1/4 10
2 5113.1106.2 SCREW MCFLTPH BZ 6-32 X 3/16 UNDERCUT 11
3 7150.0515 COVER, TOP 1
4 BXAN.0000 APX515 MAIN BOARD ASSY 1
5 BZOD.0000 CPU BOARD ASSY 1
6 5113.7108 SCREW MC SEM PH ZN 6-32 X 1/4 15
7 BSWO.0000 SOFTWARE KEY MODULE 1
8 7160.0025 TRANSFORMER COVER 1
9 5115.4132 SCREW MC TRS PH ZN 10-32 X 1-1/4 1
10 5325.0001 WASHER LOCK #10 1
11 5315.0002 WASHER FLAT #10 1
12 4522.0021 TRANSFORMER, POWER TOROID 1
13 9PEM.0515 POWER ENTRY MODULE W GROUND WIRE 1
14 5113.1110.2 SCREW MC FLT PH BZ 6-32 X 5/16 2
15 5223.0000 NUT KEP 6-32 X 5/16 3
16 7110.0006 MOUNT TRAY XFMR 1
17 5532.1106.1 SCREW, JACK 6
18 4255.0002 JACK, BANANA GNDED KNURLED 1
19 7150.0510 CHASSIS, BOTTOM/SIDES 1
20 5112.3144 SCREW MC PAN PH ZN 4-40 X 1-3/8 4
21 7330.0015 FAN GUARD CHROME 60MM 1
22 5113.7108.2 SCREW MC SEM PH BZ 6-32 X 1/4 8
23 5630.0006 FEET BLACK .25 X .5 POLYASTERMER 8
24 7321.0013 GASKET SET 60MM FAN (INCL WASHERS) 1
25 4801.0515 FAN 60MM 1
26 5222.0001 NUT KEP 4-40 4
27 4253.0012 JACK XLR PC MT RA NKL FEMALE (ON BXAN.0000) | 3
28 4253.0011 JACK XLR PC MT RA NKL MALE (ON BXAN.0000) 3
29 5515.0188 STANDOFF RND ALUM 10 X 3/16 2
30 5810.0002 HANDLE STRAP BLACK 1
31 7310.0028 BRACKET HANDLE 2
32 5115.1116.2 SCREW MC FLT PH BZ 10-32X1/2 2

APx500 Series Service Manual
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BFPM.0515 FRONT PANEL ASSY 1
33 7130.0515 PANEL, FRONT 1
34 5112.1108.7 SCREW FH PH SS BLK ZN TAPT 4-40 X 1/4 9
35 5222.0001 NUT KEP 4-40 12
36 4151.0402 CABLE ASSY 600V 2 WIRE 3.5" 2C 1
37 4254.0014 JACK, BNC ISOLATED PNL MNT 50 OHM

2172.0223 CAP, CERAMIC 200V 20% 22NF AXIAL 4

(ANALOG 1/0)

4120.2000 WIRE 20AWG 1FT (DIGITAL I/O) 1
38 4255.0002 JACK, BANANA GNDED KNURLED 1
39 5325.0002 WASHER LOCK 6
40 5241.0001 NUT JAM 6

8-6

APx500 Series Service Manual



Section 8: APx515

Figure 8-1 APx515 Chassis
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Section 9: APx1701 Transducer Test Interface

9.1 Introduction

This section covers only the APx1701 Transducer
Test Interface. The APx1701 features a two-
channel low-distortion instrument-grade power
amplifier combined with microphone power
supplies, TEDS reading capability and
impedance-measurement circuits, for electro-
acoustic testing of loudspeakers and headphones.

For general servicing guidance, please refer to
main sections of this service manual. Information
specific to the APx1701 follows here.

9.2 Functional Modules

9.2.1 ATTN Power Amplifier Module

This module contains both channels of the analog
power amplifier circuitry and the heat sink
assembly.

9.2.2 ASRN USB Interface / Mic 1/0

This module contains the USB control interface
that carries communications between the
APx1701 amplifier and the APx500 control
software. Included are the analog inputs to the
power amplifier, plus CCP or phantom power
supplies for the microphone pass-through feeds.

9.2.3 ADNE +48 Vdc, +5 Vdc supplies
This module contains +48V dc phantom power
supply, and the +5 V dc USB interface power

supply.

9.2.4 ARHE Mains power line filter

This module contains the mains line filter
circuitry and the ac power feeds to the switching
power supplies.

9.2.5 Switching dc power supplies

There are two switching power supplies
manufactured by Mean Well USA that supply the
plus and minus 48 V dc to the power amplifier
module.

9.3 Mechanical Diagram
Page 9-9.

9.4 Component Locations

* System modules and interconnection, page
9-11.

* Titan (ATTN) power amplifier module, page
9-12.

* Saturn (ASRN) USB/ Audio I/O module,
page 9-14.

* Rhea (ARHE) mains line filter module, page
9-15.

* Dionne (ADNE) +5 V and +48 V phantom
power module, page 9-16.

9.5 Adjustment and Test Point Locations
See the first pages of Section 4 earlier in this
Service Manual for general adjustment
information and for instructions on installing and
running Adjustment project(s).
* Mean Well switching power supply voltage
adjustments, page 9-17.
* Saturn (ASRN) USB/ Audio I/0O module,
page 9-18.

* Titan (ATTN) power amplifier module, pages
9-19 and 9-20.

9.6 Self Test

The APx500 SelfTest.exe software found on the
service disc includes a project to test the
APx1701. The APx1701 Self Test kit SLFT-KIT-
1701 is required to run this project; it contains a
self test fixture and necessary cabling.

We recommend that this project be run before and
after any service work is done to the instrument.
The Self Test will prompt you to install the cable
and test fixture as you proceed.

APx500 Series Service Manual
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Section 9: APx1701

9.7 Maintenance and Repair
9.7.1 Disassembly and Reassembly

Tools Needed:
* #1 Phillips screwdriver
* #2 Phillips screwdriver
* #00 size flathead screwdriver Neutrik SD-1.
* 9/16" (15 mm) deep socket wrench.
* Needle-nose pliers
* Blunt-nose pliers

Caution: Perform disassembly and
assembly in an ESD-protected

g (electrostatic discharge protected)
work area, while observing all ESD
handling requirements as described
in ANSI/ESD S20.20-1999. As a

minimum, use a grounded antistatic
work mat and wrist strap.

1. Disconnect the ac mains power cord from the
instrument.

2. Using a #2 Phillips screwdriver, remove the
fourteen 6-32 x 3/8" black screws that secure
the top cover to the APx1701 instrument.

APx1701 top cover screw locations.

3. The top cover can now be removed and set
aside with the fasteners screws in a safe place.

/N WARNING!

This protec hould ONLY be removed by qualified service
p I this cover will expose AC mains power
voltages and operating voltages that are potential shock hazards.

APx1701 with top panel removed.

9.7.2 Removing the Titan power amplifier
module assembly (ATTN)

Refer to Component Locations as necessary,

beginning on page 9-12.

4. Caution! The power amplifier must be
removed as an assembly, removing the circuit
board and heat sink together.

5. Using a set of blunt-nose pliers, disconnect all
the power supply spade lug connectors plus
the ground bonding strap at location P10 from
the Titan power amplifier module assembly.
Next, disconnect the amplifier output spade
lug connectors located at P7 and PS8. Later
models used a screw terminal connector. For
these, use a #2 Phillips screwdriver to discon-
nect the wires coming from the SpeakON out-
put connector.

6. Disconnect the two red and black twisted
cables from the front panel BNC input con-
nectors at P5 and P6. Finally disconnect the
flat ribbon control cable at P3 coming from
the ASRN USB interface module.

APx500 Series Service Manual



Section 9: APx1701

ChB

OutputN

Ch A

il

Power
Supply
Connectors
(4)

Ground
Strap

Ribbon
Cable

i
Tl

Input

ChA ‘
Output';: 5 T

3 . ‘ ChB
. Input

Titan board (rev 001).

7. Position the APx1701 in the upside-down
position and remove the four Phillips screw
fasteners, as indicated in the figure below.

APx1701 Titan mount screw locations,
on bottom cover.

8. While holding the Titan power amplifier
module assembly disconnect the red and the
black wires from the thermal sensor on the
bottom of the Titan heat sink. Carefully
remove the power amplifier Titan module
assembly and place it in a proper antistatic
enclosure.

APx500 Series Service Manual
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Section 9: APx1701

9.7.3 Removing the Saturn USB interface
controller module (ASRN)

P5 P13 P12 USB interface
cable
S s 4
paEREs, o
=i _'H!' S > (—
T, e B E
u H 0 T
g3 =<
B
e
o 4 L 1 ]
H E - 'TT = am -
{
XLR female BNC XLR male
Connectors Connector Nuts Connectors
Saturn board.
9. Using your fingers, gently disconnect the by inserting the latch tool into the small hole

USB interface cable at J6. Disconnect the
twisted red and black wire cable with the two-
pin connector at P12.

Disconnect the six-pin flat ribbon connector
at P13.

Disconnect the twenty-pin ribbon connector
at PS5.

10. Using the 9/16" (15 mm) deep socket wrench
to remove the two BNC connector panel nuts.
Using the #0-0 (5/64") flathead screwdriver Aigvgp,::;:’"
(Neutrik SD-1), unlock the XLLR connector
latch on the female and male XLLR connectors

located just above the pin 1 and pin 2 connec-
tors on the XLR connector face. This is done
by rotating the latch tool counterclockwise.
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Section 9: APx1701

CONNECTIONS 10 F

11. Using a #2 Phillips screwdriver remove the
five Phillips screw fasteners on the circuit
board.

12. Carefully remove the ASRN interface module
and place it in a proper antistatic enclosure.

13. To reinstall the ASRN module please follow
the above instructions in reverse order.

9.7.4 Removing the ADNE +5 Vdc and
+48 Vdc phantom power supply module

WARNING!—Deadly voltages present!
A Be sure the mains power cord is
disconnected.

14. This module has two separate feeds to supply
power to the two cooling fans. Remove both
of these two pin connectors at P2 and P3. The
power supply feed cable located at P1 is sol-
dered in place, leave it connected to the
ARHE board. Disconnect the other end of this
cable from the ASRN board at P13 and care-
fully draw the ribbon cable back through the

access hole in the central chassis support wall.

15. Using a #1 Phillips screwdriver remove the
four Phillips fasteners.

16. Carefully remove the ADNE module and
place it in a proper antistatic enclosure.

17. To reinstall the ADNE module please follow
the above instructions in reverse order.

9.7.5 Removing the ARHE (mains line filter)
module

WARNING!—Deadly voltages present!
A Be sure the mains power cord is
disconnected.

18. Disconnect the wiring from the chassis mount
power entry module to the ARHE module.
Remove the brown wire at P1 and the blue
wire at P2 from the spade connectors.

19. Disconnect the mains power switch wiring to
the spade connectors on the ARHE module.
Remove the orange wire from P6. Remove
the yellow wire from P5. Remove the red wire
from P3. Remove the black wire from P4.

20. Disconnect the mains power feed from the
ARHE module to the two switching dc power
supplies. Remove the BLK/WHT wire from
P8. Remove the BLK/RED wire from P7.
Remove the WHT/BLK wire from P10.
Remove the WHT/RED wire from P9.

21. Using a #2 Phillips screwdriver remove the
four Phillips screw fasteners.

22. Carefully remove the ARHE module and
place it in a proper antistatic enclosure.

23. To reinstall the ARHE module please follow
the above instructions in reverse order.

9.7.6 Removing the switching power sup-
plies

f WARNING!—Deadly voltages present!

24. To disconnect the Molex brand cable connec-
tors from the mains supply, gently pinch the
connector release to remove the mains AC
female cable connector from the switching
power supply.

25. To disconnect 48 Vdc feeds to the Titan
amplifier. Using a #2 Phillips screwdriver
unscrew the lug terminal by one turn and dis-

APx500 Series Service Manual
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Section 9: APx1701

connect the spade lug wires from the terminal
connector.

26. Using a #2 Phillips screwdriver remove the
four Phillips screw fasteners.

27. Carefully remove the switching power supply
module and place it in a proper antistatic
enclosure.

28. To reinstall the switching power supply mod-
ule, please follow the above instructions in
reverse order.

9.8 Repair/Adjustment start-up checks

9.8.1 Power Supply Checks
WARNING!—Deadly voltages present!

A Do not touch the MEAN WELL heat
sinks or other uninsulated components.

29. Check for proper dc power supply voltage at
the following locations before proceeding to
adjustments or Self Tests.

30. Measure the +48 V. dc MEAN WELL switch-
ing supply (on the right side of the chassis).
The orange wire is chassis ground; the white
wire should measure +48.5 V dc.

=

31. Measure the 48 V.dc MEAN WELL switch-
ing supply (on the right side of the chassis).

The red wire is chassis ground; the black wire
should measure —48.5 V dc.

\%\’ +Q

32. On the Saturn (ASRN) module check the
+24.0 Vdc £0.05v at the test point TP13 near
P13. Adjust R11 if the reading is not correct.

33. Check the +43.0 Vdc +0.05 at the test point
TP14. Adjust RS if the reading is not correct.

34. Check the —5.0 Vdc +0.05 at the test point
TP15.

35. Check test point TP10 for +3.3 Vdc.
36. Check P6 pin 1 for +4.9 Vdc.
37. Check P10 pin 1 for +4.9 Vdc.

9.8.2 Adjustments
Tools Needed:

* Agilent 34401 DMM or equivalent.
 Small insulated adjustment screwdriver.
* CAB-1701 cable set.

* SLFT-KIT-1701. This kit contains the SLFT-
1701 Self Test Fixture, one SpeakON to Spea-
kON cable, two BNC to BNC cables, and four
XLR female to XLR male cables. A ground
strap is also required.

» APx515, 52x or 555 Audio Analyzer.

9.8.3 Adjustment

See page 4-1 in the Adjustments Section for gen-
eral info.

See page 9-17 in this section for adjustment and
test point locations.

The adjustment projects are found on the
software disc. Open APxAdjust.exe with the USB
cable connected and the power applied.

9-6
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Section 9: APx1701

Open the APx1701 adjustment project and follow
the prompts.

9.8.4 Self Tests

The Self Test app and projects are located in the
Service \ SelfTest folder on the APx Service
Package disc.

The SelfTest.exe application will first run through
the test projects for the APx analyzer, then it will

run a separate project for the APx1701.

APx500 Series Service Manual
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Section 9: APx1701 Mechanical Diagram

9.9 Mechanical Diagram

Table 9-1: Chassis

26 ATTN.ASSY ASSY, TITAN W/HEATSINK, APx1701 1
25 ARHE.0000 PCB ASSEMBLY, RHEA 1
24 AFPN.1701 ASSEMBLY, FRONT PANEL W/SATURN, APx1701 | 1
23 AFAN.OATA FAN ASSY, APx1701 2
22 ADNE.0000 PCB ASSEMBLY, DIONE 1
21 7330.0015 FINGER GUARD, 60mm 2
20 7321.0013 GASKET SET, 60mm FAN 2
19 7310.0055 PARTITION, CHASSIS, FINISHED, APx1701 1
18 7160.0041 SHIELD, SAFETY, ELECTRICAL, FINISHED, APx1701 1
17 7150.0225 COVER, TOP, FINISHED, APx1701 1
16 7150.0150 CHASSIS, SHEET METAL, FINISHED, APx1701 1
15 5630.0011 FEET BLACK .8" ROUND 4
14 5224.0001 NUT, KEP, #8-32 1
13 5223.0001 NUT, KEP, #6-32 9
12 5222.0001 NUT, KEP, #4-40 2
11 5113.7116.2 SCREW, MC, SEM, PH, ZN, BLK, #6-32 X .38 LG 4
10 5113.7112 SCREW, MC, SEM, PH, ZN, #6-32 X .38 LG 17
9 5113.1112.2 SCREW MC FLT PH 6-32X3/8 BLK OX M/S 36
8 5113.1108.8 SCREW, FLT, PH, 100 DEG, IN, #6-32 X .25 LG 2
7 5112.3144 SCREW, MC, PAN, PH, ZN, #4-40 X 1.38 LG 8
6 5112.3112 SCREW, MC, PAN, PH, ZN, #4-40 X .38 LG 4
5 5112.3108 SCREW, MC, PAN, PH, ZN, #4-40 X .25 LG 4
4 4540.0300 PWR INVERT MEANWELL EPP-300-48 48v 2
3 4540.0009 MODULE, POWER ENTRY, APx1701, W/HW 1
2 4255.0002 JACK BANANA GNDED KNURLED 1
1 4112.0012 CABLE, USB 2.0, 12", TRIPPLITE 1
ITEM NOJ PART NUMBER DESCRIPTION QTY.
BILL OF MATERIAL

APx500 Series Service Manual
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Section 9: APx1701 Mechanical Diagram

Figure 9-1 APx1701 Chassis
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Section 9: APx1701 Component Locations
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Figure 9-2 APx1701 System Diagram
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Section 9: APx1701 Component Locations

Figure 9-4 APx1701 Titan (ATTN) power amplifier circuit board rev 1

R45
7\

021

16Y

‘z‘ [0331 071 b3 [042] [D38]

+\

& 8
slaflz| & _°
HHH /

037 k14 [040]038]

IIII!III °
3
S

&

\5\@

043

R216
c54
€53

R50
R48
R4
R1
R62
R72

R146
R144
R142
R140
R138

56

Q15

R115

R198 | [ R13s |

R215 R10S
[ ris1 | [ rio3
- R102

R101

R97

R96
RT7

. ¢

Rzls
R214
cs2
51

025

L4

j
—
2
s
|
7N\
Q35
026 [029] (17
c22 cat |
R58 Pé
3
RS9 A
c17
Rse || 2
R56

R152

c19

R95

ok74 13 [032]
[ rea |M0a4 a1zl k2

4

2|2

R80

R160

R164

R166
R170

o
o
5

R94

[e61 MosT
+

cs5 {i
c10 75

R42

m

lo4d a7 091
3
] R10 a7l fot1l K

R33

o]
R25 -RZS

-

R45

"

-1 R35

o o~ ‘

R27

o)

R113

APx500 Series Service Manual

9-13
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Section 9: APx1701 Adjustment Diagrams

9.11 Adjustment Diagrams

Z \
=
\%% N
N \

AN \ 2 :
Figure 9-8 APx1701 Mean Well +48 V dc Power Supply adjustments

WARNING!—Deadly voltages present!
A Do not touch the MEAN WELL heat sinks or other uninsulated components.

Figure 9-9 APx1701 Mean Well —-48 V dc Power Supply adjustments.

WARNING!—Deadly voltages present!
A Do not touch the MEAN WELL heat sinks or other uninsulated components.
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Section 10: Service Advisory Bulletins

10.1 Introduction

Periodically, Audio Precision issues Service
Advisory Bulletins when specific issues are
found with APx500 Series instruments. Each
Service Advisory Bulletin addresses a specific

issue and gives the recommended resolution.
When you receive a Service Advisory Bulletin,
we suggest that you add it to this section of the
service manual.

APx500 Series Service Manual

10-1
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Date: August 2006

5750 SW Arctic Drive
Service Advisory Bulletin: AP5-0001 Beaverton, Oregon 97005
Tel: 503-627-0832

. .. L Fax: 503-641-8906
To: All Audio Precision Distributors US Tol Free: 1.800.231.7350

From: Jim Duncan Service Manager

Subject: The APX-585 instrument Digital Input-Output Module Status indicators may
fail due mechanical separation of the plastic light pipe from the LED component. This
Service Bulleting covers APX-585 instruments with the rear panel serial numbers of
AP5-10525 thorough AP5-10538.

Precautions:

Proper ESD procedures should be followed to prevent ESD damage to the Digital Input-
Output Module and APX-585 instrument.

Required Parts

1. RTV Silicone Glue or any Silicone glue not harmful to electronics.
2. A quantity of two “Sealed AP” tampers labels.

Directions:

1. Disconnect the AC Mains cord from the instrument.

Place the instrument in an ESD safe working area.

Turn the APX-585 instrument over so the bottom panel is up. See Figure One

Remove the screws that secure the Bottom cover of the APX-585 instrument.

Locate and remove the Digital Input-Output Module. The module will have a serial label

with the lettering “BCIF”. See Figure Two.

6. Remove the four Front Panel attachment screws that secure the Digital Input-Output
Module. Disconnect the flat ribbon cable connector that attaches to the companion
module and remove the Digital Input-Output module form the instrument.

7. Remove the screws that attach the two support straps to the Digital Input-Output
module. Remove the straps. See Figure Two.

8. Apply a small amount of RTV Silicone glue to each of the four plastic light pipe
assemblies on the Digital Input-Output Module as shown in Figure Three.

a ks~
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9. Reassemble the two support straps to the Digital Input-Output Module using the original
mounting hardware.

10. Reinstall the Digital Input-Output Module into the APX-585 instrument using the original
Front Panel attachment screws, and reconnect the flat ribbon cable connector to the
companion module.

11. Power on the instrument and check for proper operation of the instrument using the
APX-585 Performance Check procedure. During the APX-585 Performance Check
Procedure of the Digital Input-Output module, visually check the Status Indicators for
correct operation.

12. Re-install the instrument Bottom cover using the previously removed hardware.

13. Apply the “Sealed AP” tampers label as show in Figure One.

Figure One
Bottom of the APX-585 instrument




Figure Two
APX-585 instrument Digital Input-Output Module (BCIF)

Figure Three
APX-585 instrument Digital Input-Output Module (BCIF) with Silicone glue applied

End of Service Bulletin






Service Advisory Bulletin AP5.0002
APX-585 series instruments

Date: February 2007

To: All Audio Precision Distributors

From: Jim Duncan, Technical Support Hardware Engineer

Subject: Replacement of Analog Output Module (BPLX) to eliminate possible functional defect.

Summary

Audio Precision has recently identified a minor defect in the APX-585 instrument that may
cause the Analog Unbalanced Outputs to malfunction when driving a device under test with floating
input connections at output voltage levels above 1 Volt RMS. During this failure mode the APX-585
instrument Analog Unbalanced Output signal will not produce the correct output voltage and the
distortion of the signal may be out of specification. To eliminate the function failure, anew Analog
Output Module (BPLX) will need to be installed in place of the existing module.

This service advisory covers the modifications for the Audio Precision models:
e APX-585 with instrument Serial Numbers between10526 to 10557
Please be sure that this service advisory is applicable to your instrument before proceeding.

Toolsand Required Materials
e #2 Philips screw driver.
e Needle-nosed pliers or tweezers.

e Static-protection wrist strap or other grounding device.
e |CPuller Tool

Caution

For the hardware removal and installation procedures:

Perform all tasks in an ESD-protected (ElectroStatic Discharge-protected) work area, while observing
all ESD handling requirements as described in ANSI/ESD S20.20-1999.

Disconnect all power cables and external cable assemblies from the instrument before starting the
hardware removal or installation procedures.

AP5-0002 Service Advisory Bulletin 1



Parts Required
APX-585 Analog Output Module (AP part number BPL X.0000)

Proper method for identifying an APX-585 Analog Output Module that
may need r eplacement

1. Apply AC Mains voltage to the instrument and power the instrument to the on condition.

Launch the APx-500 Operating software.
On the APx-500 Operating Software select Help and About.
On the “About APx500” Panel (see Figure 1) select the “8-Channel Analog Output Module”.

On the “ About APx500" Panel “Component Details’ the first line of information will display the
Analog Module Identification, Module Serial Number, and Revision Level.

ok wD

i
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precision:
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= @ 2006 Audio Precizion Ine. All nights rezerved. Copy to Clipboard |

Product Compaonents:

Calibration D ate d
Proceszor Board
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Figurel
Help About Menu Panel
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6. Thelast three numbers of the Module Identification Numbers indicate the Revision Level of the
Analog Output Module.

7. If the Analog Output Module Revision Level is 103 or greater, the APX-585 has the correct
modifications and no action is necessary to the APX-585 instrument.

8. If the Analog Output Module Revision Level is009, 100, 101, & 102, then contact Jim Duncan
(limd@ap.com) of Audio Precision about obtaining a replacement module (AP part number
BPLX.0000). The replacement Analog Output Module will have arevision level of 103 or
greater.

9. After receiving the replacement Analog Output Module follow the Modification Procedure
instructions.

M odification Procedure

Disassembling the instrument
10. Disconnect the ac mains power cord from the instrument.
11. Place the instrument in an ESD-safe working area.

12. Remove the APX-585 instrument cover to gain access to the Analog Output or BLPX module.
Save all the screws that secure the cover to the APX-585 instrument.

13. When viewed from the front of the APX-585 instrument, the BLPX moduleis located on the left
side, and will have alabel with the starting information of “BLPX” (See Figure 1).

—

Figurel APX-585instrument with top cover removed
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Figure 2 BLPX module and Ribbon Cable Connector

14. All interconnect cables must be disconnected before removing the BPLX module. Start by
disconnecting the Ribbon Cable Connector shown in Figure 2. The Ribbon Cable just needs to
be moved aside to allow removal of the BPLX module.
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Pin connector
from lower Front
Panel board

-
v

Pin Connector
from Front Panel
BNC board

Figure 3 BPLX Module Analog Connectionsto the Front Panel Module

15. Next disconnect the 16 connectors with the twisted red and black wires from the BPLX module.
Note the red and black wires attached to the BNC Front Panel circuit board have Ferrite beads.
The Pin connectors are polarized to prevent improper connection.
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Philips 6-32
Screws for
securing
the BPLX
module

Figure 4 APX585 BPL X Module

16. Use aPhilips # 2 Screw driver to remove the eight 6-32 Philips screws that secure the BPLX
modul e to the APX-585 main chassis plate. Save the 6-32 Philips screws for re-installation of the

new BPLX module. The 8 Philips screw locations are shown in Figure 4.

AP5-0002 Service Advisory Bulletin



Figure5 Integrated Circuit (1C) Puller Tool

17. When all the 6-32 screws are removed, the BPLX moduleis ready to be removed. The BPLX
module is attached to the BRIO module by two interconnect sockets located on the underside of
the BPLX module. NOTE: Do not use a screwdriver or other toolsto pry the BPLX module up to
disconnect the BPLX module from the BRIO module. The proper tool to lift up the BPLX
module isan IC Puller tool (shown in Figure 5). Insert the IC Puller tool into the holes on the
BPLX moduleindicated in Figure 6 and then gently lift up.

18. Once the BPL X module is removed completely from the APX-585 chassis, set it aside.

N-

Circuit Board
holes for lifting
tool

BPLX-585

BPLX
Module

Press down here
to insert the
connection

sockets correctly

Figure 6 Removing the BPL X module form the APX-585 Chassis plate.
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Installing the New BPL X module

19. Remove the replacement BPL X module from the antistatic bag and place the module onto the
APX-585 Chassis Plate. Align the screw mounting holes in the BPL X module over the mounting
standoffs. When the module is aligned correctly the threaded standoff holes will be visible
through the screw mounting holes. Press down firmly on the BPL X module on the place noted
in Figure 6.

20. Check that the BPL X module connection sockets are firmly attached to the BRIO module by
gently lifting the edges of the BPL X module. When the BPLX module is correctly attached the
edges of the module circuit board can not be lifted.

21. Install the eight 6-32 screws that secure the BPLX module to the Chassis Plate. See Figure 4 for
the location of where to mount the previously removed 6-32 screws.

22. Re-attach the 16 Analog cable connectors from the APX-585 Front Panel to the BPLX module.
See Figure 3 for placement of BNC connectors and other Front Panel connectors. Be sure to
place the twisted Red and Black cables in the same position as shown in Figure 3.

23. Insert the Ribbon Cable connector on the BPLX module (See Figure 2). The ribbon cable should
be placed as shown in Figure 1.

24. The APX-585 is how ready to check for proper operation. Connect the AC mains cable and press
the power switch to the “on” position.

25. Connect the USB cable and launch the APX500 Software. Open the Performance Check Project
and start the Performance Check project. No adjustments are necessary to the new BPLX
module.

26. If the APX-585 Performance Checks fail, contact Jim Duncan at Audio Precision
(iimd@ap.com).

27. If al the Performance Check tests pass, install the top cover of the APX-585 instrument with the
screws previously removed.

AP5-0002 Service Advisory Bulletin 8



This completes the modificationsfor the
AP5-0002 Service Advisory Bulletin

Audio-
precision

Testing for Optimal Results

5750 SW Arctic Drive
Beaverton, OR 97005

Tel: 503-627-0832

FAX : 503-641-8906

US Toll Free: 1-800-231-7350

audioprecision.com
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Service Advisory Bulletin APX-581
Pre-analyzer or Switch Model Filter

Date: May 2007

To: All Audio Precision Distributors

From: Jim Duncan, Technical Support Hardware Engineer

Subject: Modifications to the APX-581 Pre-analyzer or Switch Mode Filter to block DC voltage
from passing through the filters.

Summary

Audio Precision has recently identified a difficulty with the APX-585 instrument Analog
Analyzer when measuring AC signals with a DC component from a Class D or Switch Mode
Amplifier. The ground referenced DC voltages from the Class D or Switch Mode amplifiers may
cause the APX-585 Analog Analyzer Input Range to be incorrectly set, causing incorrect signal levels
and THD measurements. Modifying the APX-581 Filters to block DC voltages from amplifiers under
test eliminates the possibility of APX-585 measurement errors.

This service advisory covers the modifications for the Audio Precision models:
e APX-581 with serial numbers from APX1-01500 to APX1-01520

Tools and Required Materials

e #1 & 2 Philips screw driver.

e Needle-nosed pliers or tweezers.

e Static-protection wrist strap or other grounding device.

e Soldering tools: appropriate soldering iron, solder and flux remover solvent

Caution

For the hardware removal and installation procedures:

Perform all tasks in an ESD-protected (ElectroStatic Discharge-protected) work area, while observing
all ESD handling requirements as described in ANSI/ESD S20.20-1999.

Disconnect all power cables and external cable assemblies from the instrument before starting the
hardware removal or installation procedures.

Parts Required

e 8 sets of matched pairs of 1.0 MFD capacitors AP p/n 2694.0105
e 16 inches of plastic tube AP p/n 5610.0100

APX-0003 Service Advisory Bulletin 1



Modification Procedure

Disassembling the instrument
1. Disconnect all external cables from the APX-581.
Place the APX-581 in an ESD-safe working area.

3. Remove the APX-581 top and bottom covers. Save the screws for securing the cover after the
modifications are complete.

4. Please refer to Figure 1 for identification of the Filter Modules and disconnection of cables.

@ Banana Connectors
> Signal Input

P2

XLR Connector
Signal Input
P3

Signal Output
Cable Connector
P1

Figure 1
View of one of eight Filter Modules installed in an APX-581
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5. Carefully disconnect the connectors from one of the APX-581 Filter modules. Do not disconnect
and remove all the cables from all the modules, as the signal cables are not labeled and there
could be reconnection errors with the cabling.

6. Remove the four screws that secure the APX-581 Filter module to the Chassis Plate. Save the
screws for re-installation of the Filter module.

Figure 2

Close up view of the bottom of an un-modified APX-581 Filter module. The area of modification
is circled in yellow.
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Cut and remove
this trace

Cut and remove
this trace

Figure 3

Close up view of the bottom of an APX-581 Filter module with the traces cut and removed.

7. Carefully cut and remove the two traces noted in Figure 3. Do not remove the solder pad
connections for Connector P1 or the resistor solder pad connections. These connections will be
used to solder the 1 MFD capacitors.

APX-0003 Service Advisory Bulletin



Cut and solder Spacing between the
the capacitors to capacitor and the
the resistors mounting hole

Add the 1 Inch
Tubing to the 1 MFD
capacitors

Figure 4

Close up view of the top of an APX-581 Filter module with the 1 MFD capacitors installed.

8. From the modification kit locate the plastic tubing. Cut the tubing into 16 pieces, 1 inch long.
9. Insert one of the 1 inch long tubing on to one end of the 1 MFD capacitor as show in Figure 4.
10. Cut and bend the capacitors leads as show in Figure 4.

11. Solder both capacitor leads to the resistors on the top side of the APX-581 Filter modules as
shown in Figure 4.

12. Be sure to mount the 1 MFD capacitors with the spacing between the end of the capacitor and the
APX-581 Filter module mounting holes as shown in Figure 4.

APX-0003 Service Advisory Bulletin 5
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Solder both
capacitor leads as
shown

Figure 5

13.

14.
15.
16.
17.

18.
19.

Close up view of the bottom of an APX-581 Filter module with the soldered Capacitor leads.

Cut and solder the leads of the 1 MFD capacitors to the bottom of the APX-581 circuit board as
shown in Figure 5. Be sure to leave space between the circuit board mounting holes and the
capacitor leads as shown in Figure 5.

Clean all solder joints with approved solder flux remover.
Inspect all solder joints for proper joints.
Inspect the modifications for correct connections.

Place the APX-581 module into the same position the module was originally installed. Attach the
4-40 screws that secured the module to the chassis plate.

Reconnect the cables as show in Figure 1.

Remove, modify, and re-install one by one each of the APX-581 modules until all eight modules
have been modified.

APX-0003 Service Advisory Bulletin 6



20. Testing of the completed modules?
21. Reassembling the instrument.

APX-0003 Service Advisory Bulletin



This completes the modifications for the
APX-0003 Service Advisory Bulletin

Audio-
precision

Testing for Optimal Results

5750 SW Arctic Drive
Beaverton, OR 97005

Tel: 503-627-0832

FAX : 503-641-8906

US Toll Free: 1-800-231-7350

audioprecision.com
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Service Advisory Bulletin APX.0004
Failure of APx500 software to recognize the APx585 or APx586
instrument

Date: June 2008
To: All Audio Precision Distributors
From: Jim Duncan, Technical Support Hardware Engineer

Subject: Troubleshooting the power supplies, BZOD memory, and BZOD module when APx500
software fails to recognize the APx585 or APx586 instrument.

Summary:

Audio Precision has discovered certain rare failure conditions that will prevent the APx500 software
from recognizing the APx585 or APx586 instrument. This Service Advisory Bulletin goes through the
necessary steps to check the power supplies, BZOD memory, and BZOD module in order to locate and
correct the problem.

This service advisory covers the Audio Precision APx585 and APx586.

Tools and Required Materials:

e #2 Phillips screw driver.
e  Static-protection wrist strap or other grounding device.
e APx585/586 service manual.

Caution: Perform all hardware removal and installation procedures in an
ESD-protected (electrostatic discharge protected) work area, while observing
all ESD handling requirements as described in ANSI/ESD S20.20-1999. As a
minimum, use a grounded anti-static work mat and wrist strap.

@y Important: Disconnect all power cables and external cable assemblies from the
instrument before starting the hardware removal or installation procedures.

Troubleshooting Procedure:

Verification
1. Verify the following before proceeding, to rule out other common connectivity issues:
e Theinstrument is connected to the AC mains and the power indicator islit.

APX.0004 rev 1 Service Advisory Bulletin 1



e A good USB cableis connected between the instrument and the controlling computer.

e Launching the APx585 operating software produces the error message “APX Hardware not
properly installed or powered on and will run in Demo Mode”.

e Theinstrument was previously operating correctly with the attached computer.
2. If theinstrument meets the above conditions, continue with the troubleshooting procedure.

Power Supply Checks
3. Disconnect the AC mains cord and USB cable from the APx585/586 instrument.
4. Remove thetop cover

5. Reconnect the AC mains cord and press the front panel power switch to turn on the instrument. Do
not reconnect the USB cable.

6. Inspect the LED indicators (figure 1 point A and B) on the module located in between the power

Figure 1 Power supply indicators

7. TheLED indicator at point A should be flashing at a slow rate.
8. TheLED indicators at point B should be lighted and not flashing.

9. These LED indicators show the status of the various DC supply railsin the instrument. If any of the
power supply LED indicators are not lighted as shown in figure 1, the power supply module (point
C) may be failing and need to be repaired or replaced.

APX.0004 rev 1 Service Advisory Bulletin 2



BZOD Module Checks

10. The LED indicators located on the BZOD module (figure 2) will indicate the instrument status
during the initial instrument start up and launch of the APx500 control software.

Figure 2 BZOD module

11. Power off the instrument, and then power it on while observing the LED indicators. During the
initial start-up of the APx585 instrument, the BZOD module LED indicators shown in figure 2 will
be asfollows:

e PointA=0n
e Point B = Off
e Point C = Off
e Point D = Off.
12. Now, launch the APx500 software and observe that the LEDs show as follows:
Point A =0On
Point B = Off
Point C = On
Point D will be flashing On and Off.

13. If all the BZOD module LED indicators are lighted, then the memory assembly (figure 3 point A)
on the BZOD module may not be fully inserted into the mounting socket (figure 3 point B).

APX.0004 rev 1 Service Advisory Bulletin 3
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Figure 3 BZOD module and BZOD memory module

14. To reseat the memory module, disconnect the AC mains cord from the instrument, and remove the
memory assembly from the mounting socket. Re-install the memory assembly into the mounting
socket. Re-connect the AC mains cord and observe the LED indicators for the correct On or Off
sequences described in steps 11 and 12. If the LED indicators are lighted correctly, replace the
instrument cover and conduct a Performance Check of the APx585 instrument.

15. If the BZOD module LED indicators still do not indicate the correct On and Off indications, then it
is recommended to replace the BZOD module. Contact Jim Duncan (jimd@ap.com) to obtain
replacement modules for APx585 instruments, and proceed with the following steps to replaceit.

Replacing the BZOD module
16. Power off the instrument and remove the AC mains cord.
17. On the rear panel, remove the six threaded studs that secure the connectors A, B, and C in figure 4.

Figure 4 APx rear panel
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18. Save the threaded studs. These will be re-used to secure the new BZOD module.

19. Locate and remove the five screws that secure the BZOD module as shown in figure 5 (Points A,
B, C, D, & E). Savethe screwsfor the installation of the new BZOD module.

Figure 5 BZOD module screws

20. Remove the BZOD module while gently pushing the fan at point F out of the way.

21. Install the new BZOD module, replacing the five screws removed in step 18 and the threaded studs
removed in step 16.

22. Power on the APx585 instrument and check the LED indicators for proper operation as described
in steps 11 and 12.

23. If replacing the BZOD Module and memory assembly do not restore the instrument to operating
conditions, contact Jim Duncan (jimd@ap.com) to obtain Factory Service of the APx585

instrument.
precisionr
5750 SW Arctic Drive
Beaverton, Oregon 97005
800-231-7350
ap.com info@ap.com

V1110701141600
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Service Advisory Bulletin APX.0005
Replacement of Early HDMI Modules in APx585 Instruments

Date: July 2008
To: All AP Distributors
From: Jim Duncan, Technical Support Hardware Engineer

Subject: Replacement of early HDMI modules in APx585 instruments with the current production
version.

Summary:

A small number of APx585 instruments were shipped with an early version of the HDMI modul e that
isincompatible with APx500 software version 2.2 and later. This bulletin gives instructions for
replacing the HDMI module with the current version, and then testing the instrument.

This service advisory covers the Audio Precision APx585.

Tools and Required Materials:

e #2 Phillips screw driver.
e Static-protection wrist strap or other grounding device.

Parts List:

Qty Part Number Description

1 BHDM.0000 HDMI Module

1 8411.1725 APx500 version 2.2 measurement software
1 8411.1726 APx Resources Disc

Caution: Perform all hardware removal and installation procedures in an
ESD-protected (electrostatic discharge protected) work area, while observing
all ESD handling requirements as described in ANSI/ESD S20.20-1999. As a
minimum, use a grounded anti-static work mat and wrist strap.

@b Important: Disconnect all power cables and external cable assemblies from the
instrument before starting the hardware removal or installation procedures.

APX.0005 rev 0 Service Advisory Bulletin 1




HDMI Module Replacement Procedure:

Replacement
1. Remove both the top and bottom covers of the APx instrument. Turn the instrument upside down.
2. Remove the four screws that secure the HDMI front panel to the instrument, as shown in figure 1.

10 AUDIO /
PATTERN VIDEO.
GENERATOR MONITOR

Figure 1 Front panel screws

3. Remove the four screws that secure the HDMI circuit board (BVID), as shown in figure 2.

Figure 2 BVID circuit board screws

4. Gently lift the end of the BVID board to unplug it from the connector, as shown in figure 3.

APX.0005 rev 0 Service Advisory Bulletin 2
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Figure 3 Unplugging the BVID board

5. Slidethe old HDMI module out the front of the instrument. Note that it will be necessary to tilt it,
as shown in figure 4, to clear the front panel.

6. Insert the new HDMI module through the front panel, tilting it as shown in figure 4. Push the end
of the card into the connector, and replace the four circuit board screws and the four front panel
screws.

7. Upgrade the APx500 measurement software to version 2.2 or higher.
Power Supply Checks

8. Turntheinstrument over so it isright side up.
9. Attach the AC mains cord and turn on the instrument.

APX.0005 rev 0 Service Advisory Bulletin 3



10. Inspect the LED indicators (figure 5 point A and B) on the module located in between the power
supply module (figure 5 point C) and the support frame (figure 5 point D).

Figure 5 Power supply indicators

11. The LED indicator at point A should be flashing at a slow rate.
12. The LED indicators at point B should be lighted and not flashing.

13. These LED indicators show the status of the various DC supply railsin the instrument. If any of the
power supply LED indicators are not lighted as shown in figure 5, double check that the HDMI
module has been correctly installed.

BZOD Module Checks

14. The LED indicators located on the BZOD module (figure 6) will indicate the instrument status
during theinitia instrument start up and launch of the APx500 control software.

APX.0005 rev 0 Service Advisory Bulletin 4



15. Power off the instrument, and then power it on while observing the LED indicators. During the
initial start-up of the APx585 instrument, the BZOD module LED indicators shown in figure 6 will
be asfollows:

Point A =0On
Point B = Off
Point C = Off
Point D = Off.

16. Now, launch the APx500 software and observe that the LEDs show as follows:

Point A =0n
Point B = Off
Point C = On
Point D will be flashing On and Off.

Performance Checks

17. Run the APx performance check procedure, and then the APx HDMI performance check
procedure, to verify that the instrument is operating properly.

18. If the instrument fails the BZOD module checks or the performance checks, contact Jim Duncan
(jimd@ap.com) to obtain factory service for the APx585 instrument.

APX.0005 rev 0 Service Advisory Bulletin 5
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Service Advisory Bulletin APX.0006
Correction of 50 kHz Response Peak in APx585/586 Instruments

Date: July 2008
To: All AP Distributors
From: Jim Duncan, Technical Support Hardware Engineer

Subject: Correction of 0.01dB response peak at 50 kHz in APx585/586 instruments with BCAS
Analog Input board revision 201.

Summary:

APx585 and APx586 instruments with BCAS Analog Input board revision 201 may fail calibration due
to a response peak of 0.01dB at 50 kHz. This bulletin gives instructions for replacing two resistors in
each input channel, and then testing the instrument. Instruments with BCAS Analog Input board
revision 202 and higher do not need to be modified.

Tools and Required Materials:
e #1 Phillips screw driver.
e Static-protection wrist strap or other grounding device.

e Surface mount device (SMD) soldering equipment.

Parts List:
Oty Part Number Description
16 1176.5629 Resistor 56.2 Ohms 1/8 Watt 1% SMD 1206 (RoHS compliant)

Caution: Perform all hardware removal and installation procedures in an
ESD-protected (electrostatic discharge protected) work area, while observing
all ESD handling requirements as described in ANSI/ESD S20.20-1999. As a
minimum, use a grounded anti-static work mat and wrist strap.

@ Important: Disconnect all power cables and external cable assemblies from the
instrument before starting the hardware removal or installation procedures.
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BCAS Module Upgrade Procedure:

1. Use a #2 Phillips screwdriver to remove the ten 4-40 gray painted screws that secure the instrument
top cover. Save these screws for re-installing the top cover later. If the instrument is an APx586,
then also remove the 18 gray 4-40 screws and 6 unpainted 4-40 screws that secure the bottom
cover.

Important: Use the appropriate SMD tips and/or hot air tool to remove and
replace the SMD resistors. Use of improper tools may damage the components

and the circuit board.

2. Change resistors R105 and R112 in input channel 1 of the BCAS module from 59.0 Ohms to 56.2
Ohms using the AP part specified above or its equivalent. Do the same for input channels 2 — 7
(R205/R212,...). See the resistors highlighted in figure 1.
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BCAS module with resistors highlighted.
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3. If the instrument is an APx586, turn it over and make the same replacements on the other BCAS
module.

. On the BCAS module identification sticker, if the revision number is 201, correct it to say 202.
5. Run the adjust585-586v2.2.approj from the APx Service Disc to readjust the BCAS module(s).

6. Run the performance check APx585PerformanceCheckv2 2.approj or
APx586PerformanceCheckv2 2.approj as appropriate from the APx Resources Disc to verify
correct operation of the instrument and the Digital I/O module. Then run
DigitalBalancedPerformanceCheckV2 2.approj to verify correct operation of the balanced digital
I/O connections.

7. If the instrument was calibrated, re-calibrate the instrument.

8. Replace the top and bottom covers.
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Service Advisory Bulletin APX.0007
Measurement Errors in Digital Loopback Mode

Date: July 2008
To: All AP Distributors
From: Jim Duncan, Technical Support Hardware Engineer

Subject: Measurement errors in digital loopback mode in APx585 and APx586 instruments.

Summary:

When the APx-585 or APx-586 AES digital signal path setup is in digital loopback mode at sample
rates higher than 48 kHz, the digital receiver may overload and display inaccurate measurements.
Modifying the BAES module to reduce the signal level of the digital generator to analyzer signal path
eliminates the probability of overloading the digital receiver and producing inaccurate measurements.

This bulletin gives instructions for making a small circuit modification and testing the instrument. The
BAES board is part of the model 110 Digital I/O module with balanced XLR connectors. This
modification does not apply to instruments that contain the earlier model 109 Digital I/O module
without XLLR connectors.

This service advisory applies to the following Audio Precision instruments:

e APx585 and APx586 with model 110 Digital I/O module, and BAES module revision 000, 001,
or 002. Instruments with BAES module revision 003 or higher do not need to be modified.

Tools and Required Materials:
e #1 Phillips screw driver.
e Static-protection wrist strap or other grounding device.

e Surface mount device (SMD) soldering equipment.

Parts List:
Qty  Part Number Description
2 1176.1500.1 Resistor 150 Ohms 1/8 Watt 1% SMD 0603 (RoHS compliant)

Caution: Perform all hardware removal and installation procedures in an
ESD-protected (electrostatic discharge protected) work area, while observing
all ESD handling requirements as described in ANSI/ESD S20.20-1999. As a
minimum, use a grounded anti-static work mat and wrist strap.
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@y Important: Disconnect all power cables and external cable assemblies from the
instrument before starting the hardware removal or installation procedures.

BAES Module Upgrade Procedure:

1. Use a #2 Phillips screwdriver to remove the 18 gray 4-40 screws and 6 unpainted 4-40 screws that
secure the bottom cover.

Important: Use the appropriate SMD tips and/or hot air tool to remove and
replace the SMD resistors. Use of improper tools may damage the components

and the circuit board.

2. Locate the BAES module on the bottom of the instrument behind the Digital I/O module. See
figure 1.
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BAES module

Figure 1 BAES Digital I/O module.

3. Note the modification area on the circuit board layout in figure 2.
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Figure 2 BAES module with modified area highlighted.
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4. Change R319 to from 49.9 Ohms to 150 Ohms, as shown in figure 3.
5. Add anew 150 Ohm resistor (R327) next to C306, as shown in figure 3.
6. Add a jumper wire between R327 and R324 as shown in figure 3.

PRSI g e A SRR B

Fiure 3 BAES modification close-up.

7. On the BAES module identification sticker, if the board rev says 002, change it to say 003. If the
board is rev 000 or 001, do not change the revision but add “w ECO 08-50.”

8. Run the performance check APx585PerformanceCheckv2 2.approj or
APx586PerformanceCheckv2 2.approj as appropriate from the APx Resources disc to verify
correct operation of the instrument and the Digital I/O module. Then run
DigitalBalancedPerformanceCheckV2 2.approj to verify correct operation of the balanced digital
I/O connections.

9. Ifthe instrument was calibrated, re-calibrate the instrument.
10. Replace the bottom cover.
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Service Advisory Bulletin APX.0008
Playback Error of Non-192 kHz Files with APx585/586

Date: August 2008
To: All AP Distributors
From: Jim Duncan, Technical Support Hardware Engineer

Subject: Playback error of non-192 kHz files in APx585 and APx586 instruments with older BPLX
analog output modules.

Summary:

Early APx585 and APx586 instruments with BPLX module revisions 100—106 and 300 did not
properly support waveform file playback through the analog outputs at sample rates other than 192
kHz. Playback through the digital outputs is not affected. APx500 v2.2 and later measurement software
requires lower sample rates to use the waveform file playback feature. Trying to play back a non-192
kHz file with the analog outputs selected will result in the following error message:

% Audio Precision Error,

The hardware is not capable of playing this waveform. Please contact Audio Precision
@ technical support for assistance.

Details ~

Correcting this issue requires a firmware upgrade on the BPLX board. US customers will need to
contact Jim Duncan (jimd@ap.com) to arrange an RMA. Normal factory service fees apply. European
and Asian customers will need to contact their distributor to exchange their current BPLX board for
either version 107, or 301 or later.

To identify the current BPLX version, in the APx500 measurement software, go to Help>About, scroll
to “8-Channel Analog Output Board”, and under Component Details, read the last three digits in the
first line. For example, if the first line reads “ID: BPLX-15095-105", then the version is 105.

Audio==:;
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Service Advisory Bulletin APX.0010
Rare Audio Bit-stream Corruption with Coded Audio

Date: February 2009

To: All AP Distributors

From: Jim Duncan, Technical Support Hardware Engineer
Subject: Rare audio bit-stream corruption with coded audio.
Applies to: APx585 with HDMI main board BVID rev 000.

Summary:

HDMI option modules with BVID circuit board module revision 000 may on rare occasions exhibit
audio bit-stream corruption. The Sil9135CTU receiver component has been identified as the source of
the corrupted audio bit-stream by its manufacturer. BVID module revisions 001 or higher now use the
improved Sil9135ACTU receiver. Revision 000 modules that exhibit corrupted audio bit-stream data
on a semi-regular basis should be replaced with modules that are revision 001 or higher. The BVID
revision level can be identified from the Help > About menu selection in the APx500 Measurement
Software.

Tools and Required Materials:
e #1 and #2 Phillips screwdrivers.

e Static-protection wrist strap or other grounding device.

Parts List:

Qty  Part Number Description

1 BHDM.0000 HDMI Module

1 8411.1725 APx500 Measurement Software
1 8411.1726 APx Resources Disc

Caution: Perform all hardware removal and installation procedures in an
ESD-protected (electrostatic discharge protected) work area, while observing
all ESD handling requirements as described in ANSI/ESD S20.20-1999. As a
minimum, use a grounded anti-static work mat and wrist strap.

@ Important: Disconnect all power cables and external cable assemblies from the
instrument before starting the hardware removal or installation procedures.
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HDMI Module Replacement Procedure:

Replacement

1. Using a #2 Phillips screwdriver, remove both the top and bottom covers of the APx instrument.
Turn the instrument upside down.

2. Using a #1 Phillips screwdriver, remove the four screws that secure the HDMI front panel to the
instrument, as shown in Figure 1.

@ e

Figure 1 Front panel screws

3. Remove the four screws that secure the HDMI circuit board (BVID), as shown in Figure 2.

Figure 2 BVID circuit board screws

4. Gently lift the end of the BVID board to unplug it from the connector, as shown in Figure 3.
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Figure 3 Unplugging the BVID board

5. Slide the old HDMI module out the front of the instrument. Note that it will be necessary to tilt it,
as shown in Figure 4, to clear the front panel.
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Figure 4 Removing the old HDMI module

6. Insert the new HDMI module through the front panel, tilting it as shown in Figure 4. Push the end
of the card into the connector, and replace the four circuit board screws and the four front panel
SCIews.

Power Supply Checks
Turn the instrument over so that it is right side up.
Attach the AC mains cord and turn on the instrument.

Inspect the LED power supply indicators (Figure 5) on the BRIO module located in between the
Power Supply module (Point C) and the support frame (Point D). The LED indicator at Point A
should be flashing at a slow rate. The LED indicators at Point B should be lighted and not flashing.
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Figure 5 Power supply LED indicators on the BRIO Distribution module.

BZOD Module Checks

10. The LED indicators located on the CPU/USB module (BZOD) (Figure 6) will indicate the
instrument status during the initial instrument start up and launch of the APx500 Measurement

Software.

> € o=
e

Figure 6 BZOD module LED indicators.

APX.0010 rev 1 Service Advisory Bulletin



11. Power off the instrument, and then power it on while observing the LED indicators. During the
initial start-up of the APx instrument, the state of the BZOD module LED indicators at each point
shown in Figure 6 will be as follows:

e A=0On
e B=O0ff
o (C=0ff
e D=0fFf

12. Now, launch the APx500 software and observe that the LEDs indicate as follows:
e A=0On
e B=O0ff
e C=0On
e D =Flashing

Performance Checks

13. Run the performance check project (APx585PerformanceCheckVx_x.approj) for the instrument.
The performance check files may be obtained from the APx Resources disc or the AP website.
Also run the separate HDMI performance check project (HdmiPerformanceCheckVx_x.approj) to
verify that the new HDMI module is performing correctly.

14. If the instrument fails the power supply, BZOD, or performance checks, verify that the HDMI
module has been installed and connected correctly.

15. If the instrument still fails the checks or otherwise fails to function properly, please contact Jim
Duncan at Audio Precision (jimd@ap.com) to obtain factory service for the instrument.

16. If all checks pass, replace the top and bottom covers that were removed in Step 1.

17. Opening the case voids calibration. If the instrument was previously calibrated, it should be
re-calibrated at this time.

Audio==:;
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Service Advisory Bulletin APX.0012
Optical Transmitter and Receiver Compatibility

Date: July 2009
To: All AP Distributors
From: Jim Duncan, Technical Support Hardware Engineer

Subject: Compatibility of old and new type optical transmitter/receiver components with various
Digital I/O module board revisions.

Applies To: APx525, 526, 585, and 586 manufactured before May 2009.

Summary

The APx AES Digital Input/Output module is composed of two sub-modules: a main module (BAES),
and a front panel module (BSOP). The BSOP module contains optical transmitter and receiver
components that are no longer available and have been replaced with new parts in current production.
This change also has required revision of the BAES module. Therefore, when servicing the Digital I/O
module, it is important to check the sub-module serial number labels to make sure that the optical
components and the BAES module are the correct match. Installation of optical components that are
not correctly matched will cause less than optimum performance of the AES digital optical signals.
Audio Precision has sufficient stock of the older optical components for service.

DIGITAL 1/O OPTICAL COMPONENTS AND COMPATIBLE MODULE REVISIONS:

Optical Components AES Digital /0 Modules

AP Part No. Manu. Part No. BSOP Revision No. BAES Revision No.
3640.RCVT | TX142L BSOP-XXXXX-100* and BAES-XXXXX-000 through
3640 RCVR RX142L BSOP-XXXXX-101* BAES-XXXXX-004

3640.147T TX147L

BSOP-XXXXX-102 and higher | BAES-XXXXX-100 and higher
3640.147R RX147L

* This revision was manufactured with the older optical components. Check, however, that it has not already been refitted with the new ones.
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Service Advisory Bulletin APX.0013
Failure of RFI Suppression Capacitors on Analog I/O Panels

Date: August 2009

To: All AP Distributors

From: Jim Duncan, Technical Support Hardware Engineer

Applies To: APx models 520, 521, 525, 526, 585, and 586 manufactured before December 13, 2008.

Action: Audio Precision requires the replacement of the Analog Input and Output panels on
instruments that are returned for service or calibration.

Summary:

The unbalanced BNC analog signal connectors used on all APx Analog Input and Output panels have
RFI (radio frequency interference) suppression capacitors. The capacitors are mounted between each
BNC shell and the chassis frame. Instruments manufactured before December 13, 2008 used SMT
capacitors that may fail due to mechanical stress or vibration, resulting in reduced EMI suppression.
Failure of the capacitors will not alter an instrument’s ability to meet factory specifications.

Audio Precision requires the replacement of Analog Input and Output Panels that use SMT (surface
mount) capacitors with new panels that use axial lead capacitors on all APx500 series instruments
manufactured before December 13, 2008 that are returned for service or calibration. Affected APx
instruments that already contain new panels will have “SAB-13" written on the rear panel label.

To determine the date of manufacture, read the label on the rear panel, or go to Help|About in the
APx500 Measurement Software and read the manufacturing date for the Analog Input and Output
modules.

Tools and Required Materials:

e #1 and #2 Phillips screw driver.

e Static-protection wrist strap or other grounding device.

Caution: Perform all hardware removal and installation procedures in an
ESD-protected (electrostatic discharge protected) work area, while observing
all ESD handling requirements as described in ANSI/ESD S20.20-1999. As a
minimum, use a grounded anti-static work mat and wrist strap.
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Parts:

Once it is verified that the panels need replacement, order new panels according to the following table.
After completing the replacement, return the old panels to Audio Precision.

Table 1 Analog front panel module part numbers.

Instrument Output Panel Input Panel Additional Input Panel
APx520 BAOU.2000 BAIN.2000 n/a
APx521 BAOU.2000 BAIN.2000 BAIN.3000 (chan 3/4)
APx525 BAOU.2000 BAIN.2000 n/a
APx526 BAOU.2000 BAIN.2000 BAIN.3000 (chan 3/4)
APx585 BAOU.0000 BAIN.0000 n/a
APx586 BAOU.0000 BAIN.0000 BAIN.1600 (chan 9-16)

Audio Precision recommends conducting a performance check to verify proper
operation before opening up the instrument.

Analog Panel Replacement:

Verification
1. Determine if the instrument’s analog input and output panels should be replaced as follows:

a. Check the date of manufacture on the rear panel label. If the date is December 2008 or later,
stop here. The instrument already has the new panels.

b. If the label is not legible, Go to Help|About in the APx500 software. Scroll down and check
the date of manufacture of the Analog Input and Analog Output modules. If the date is
December 2008 or later, stop here. The instrument already has the new panels.

c. If“SAB-13” is written on the rear panel label, then stop here. The instrument already has
the new panels.

2. Remove the top cover of the instrument and inspect the capacitors on the back of the analog input
and output panels. If the instrument has 4 or 16 analog input channels, also remove the bottom
cover to inspect the second analog input panel. Refer to Figure 1.

a. If the Analog Input or Analog Output panels have through-hole axial capacitors, then the
instrument already has the new panels. Write “SAB-13" on the rear label. Replace the
covers and stop here.

b. If the panels have SMT (surface mount) capacitors, continue with the replacement
procedure.

APX.0013 rev 0 Service Advisory Bulletin 2



Fig 1 BNC connectors mounted on front panels. Left has old style SMT RFI suppression capacitor. Right has new
style axial through-hole RFI suppression capacitor.

Repeat the following replacement procedure for each Analog Input and Output
panel in the analyzer. We recommend removal and replacement of one analog

panel at a time. This will help to reduce installation errors.

Replacement

3. Disconnect the black ribbon cable connector from the back side of the Analog Output or Input
panel.

4. On the back side of the panel, there are red and black wires with connectors for each channel that
plug into the large Analog Output or Input module circuit board behind. Unplug each one. If the
plastic polarizing connector shell mounted to the large circuit board detaches with the panel
connector, remove the shell and correctly re-install it.

5. Remove the gray painted 4-40 screws that secure the panel to the front of the instrument. Slide the
panel out and away. This panel will not be used again, and will need to be returned to Audio
Precision USA.

6. Remove the new panel from the antistatic bag. Straighten the red & black wire pairs so that they
will pass easily through the opening in the front of the instrument.

Use the gray painted 4-40 screws that were previously removed to secure the new panel.

8. Plug the red and black wire connectors into their correct locations on the Analog Input or Output
modules. Note that the positioning of the red and black wires in important in order to not
compromise crosstalk. Refer to Figures 2-5 below.
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Fig 2 APx52x Analog Output panel and module.

Fig 4 APx585/586 Analog Output panel and module.
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Fig 5 APx585/586 Analog Input panel and module.

Completion

9. Power on the instrument and run the APx Performance Checks. If the Performance Checks fail,
recheck the installation of the red and black wire connectors to the Analog modules. If the test
failures persist, contact Jim Duncan at Audio Precision.

10. If the Performance Check tests all pass, reinstall the top and bottom (if removed) covers. Write
“SAB-13” on the back panel label.

11. Send the old Analog Input and Output panels that were removed to Audio Precision USA.

12. Opening the case voids calibration. If the customer requires calibration, the instrument should be
re-calibrated at this time.
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Service Advisory Bulletin APX.0014
Output Protection Threshold Level and Circuit Modification

Date: August 2009
To: All AP Distributors
From: Jim Duncan, Technical Support Hardware Engineer

Subject: Modifications to increase the maximum threshold level and reduce the switching response
time of the threshold level generator circuit.

Applies To: APx models 520, 521, 525, and 526 with BMEG module revision 004 or earlier.

Summary:

The AGS52 option increases the maximum analog output level that the generator is capable of
producing. To accommodate the AG52, the output protection circuit on the BMEG Analog Output
module must be modified to increase the high-range protection threshold level to prevent false
triggering on high output level signals. In addition, this Service Advisory Bulletin includes another
modification to improve the response time when switching between the high and low threshold levels.
The circuit changes in this document are also included as part of the AG52 Upgrade Kit Instructions
(AP doc 8211.0275). Audio Precision recommends implementing these modifications to all affected
APx52x Series instruments that are returned for calibration, adjustment, or repair, regardless of
whether the AG52 is being installed.

Table 1 Affected instruments

BMEG Revision | Status Implement SAB-14
005 or higher* Any No
004 or lower* AG52 installed No

SAB-14 marked on rear label No

Neither AG52 nor SAB-14 on Yes
label

* To determine the BMEG Analog Output module revision, read the label on the module, or go
to Help|About in the APx500 Measurement Software.

Tools and Required Materials:

e #1 Phillips screwdriver.

e Static-protection wrist strap or other grounding device.

e Male XLR to female XLR cable 1m (quan 2).

e Male XLR to female XLR digital 110 Ohm cable (APx525/526 only, quan 1).

e Male BNC to male BNC (50 or 75 Q) cable 1m (APx520/521, quan 2; APx525/526, quan 3).
e Toslink optical digital cable (APx525/526 only, quan 1).
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e BNC to Banana cable, or BNC to BNC cable with BNC to banana adapter.

Parts List:
Part Number Description Quan
1176.1432.1 Resistor, 14.3k SMT
1176.3241.1 Resistor, 3.24k 1% SMT

@ Important: Disconnect all power cables and external cable assemblies from the
instrument before starting the hardware removal or installation procedures.

Protection Circuit Modification:

Preparation
It is recommended to conduct both a performance check and a calibration of the APx instrument before
performing this modification.
The performance check will verify correct operation of the instrument. The appropriate performance
check project for the instrument may be obtained from the APx Resources disc or the AP website.

The calibration will document the pre-upgrade condition of the APx instrument and ensure that it
conforms to AP factory specifications. Please refer to your company’s ISO-9000 or ISO-17025
documents for calibration requirements.

Important: Opening the instrument to perform this modification will invalidate its
current calibration. Therefore, calibration is recommended after the upgrade to

re-certify the instrument.

Modification

1. Use a #1 Phillips screwdriver to remove the ten 4-40 gray painted screws that secure the instrument
top cover. Save these screws for re-installing the top cover later.

2. In the front left corner of the BMEG module, locate R175 and change it from 19.3k to 14.3k (AP
p/n 1176.1432.1). Do the same for channel 2 (R277). See Figure 1.

3. Beside the resistor that was just changed, locate Q102. Solder new resistor R199 3.24k 1% (AP p/n
1176.3241.1) across the emitter and base as shown in Figure 1. Do the same for channel 2,
soldering a new resistor R299 across Q202.
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Fig 1 BMEG module modifications.

Verification

6. Power on the instrument and start APx500 Measurement Software version 2.4 or higher.

10.

11.

12.
13.

14.

Open a new project, and set the signal path Output Configuration to Analog Unbalanced and the
Input Configuration to Loopback.

Set the generator frequency to 300 Hz and the level to 1 Vrms. Turn on the generator.

. Place a multimeter between ground and U101 pin 1 and check for -90 to -95 mVDC. Do the same

at U201 pin 1 for the other channel.

Increase the generator level to 2 Vrms. Now check for -440 mVDC to -460 mVDC at the same
points.

Download the APx Series Performance Checks from ap.com and run PerfCheck.exe to check the
entire instrument.

If the performance checks pass, replace the top and bottom covers.

If the voltage checks in steps 9 and 10 fail, or the performance checks in step 11 fail, please contact
Jim Duncan at Audio Precision (jimd@ap.com) to obtain factory service.

Re-calibrate the instrument if required.

Judio
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Service Advisory Bulletin APX.0015
Failure of Software to Recognize Instrument
(BZOD Firmware Upgrade)

Date: September 2009

To: All AP Distributors

From: Jim Duncan, Technical Support Hardware Engineer

Applies To: All APx instruments manufactured before August 2009.

Action: Audio Precision requires that the BZOD firmware be upgraded on all instruments that are
returned for service.

Summary:

On rare occasions, an instrument may fail to be recognized when the APx500 Measurement Software
is started. In the majority of these rare instances, the APx instrument will be recognized after simply
closing and restarting the software. In other instances, powering off the APx instrument for a brief
period, then powering it on and restarting the APx control software, will allow it to be recognized.
Improvements have been made to the BZOD (CPU/USB) module firmware to correct this rare start up
condition. Audio Precision requires that the BZOD firmware be upgraded on all instruments that are
returned for service.

Tools and Required Materials:

e APx Measurement Software version 2.4 or later.

e Desktop PC with USB 2.0 port and battery backup (UPS), or notebook PC with 30 minutes
minimum battery run time.

e Battery backup (UPS) for the APx instrument.
e Spare BZOD module.

Important: If the firmware upgrade procedure is interrupted, the instrument may be
@y rendered inoperative until the BZOD module is replaced. Therefore, do not attempt

the upgrade unless battery backup and a spare BZOD module is available.

APX.0015 rev 0 Service Advisory Bulletin 1



Firmware Upgrade:

Eligibility Check

All instruments manufactured before August 2009 should be upgraded. To determine the date of
manufacture, read the label on the rear panel, or go to Help|About in the APx500 Measurement
Software and read the manufacturing date for the BRIO Main Interconnect module.

If you are unsure if the BZOD firmware has already been upgraded, you may use the following method
to determine the firmware version:

a) Power on the instrument and start the APx500 software version 2.4 or later.
b) After it fully loads, close the APx500 software and power off the instrument.
c) Disconnect the USB cable.

d) Connect a null-modem cable to the “Software Options” connector on the rear of the instrument.
Connect the other end to COM 1 on the PC.

e) Start HyperTerminal or an equivalent terminal emulation program on the PC. Set it to 8/N/1,
115,200 baud, and flow control off.

f) Power on the instrument.

g) HyperTerminal will display a series of text messages, including the boot version, as follows:

Boot 0 version is: 5

h) If the version is 5 or below, the firmware upgrade is needed. If the version is 7 or above, the
instrument already has upgraded firmware and you may stop at this point.

1) Power off the instrument, remove the null-modem cable, and reconnect the USB cable.

If you are unable to determine the BZOD firmware version, you may proceed to perform the upgrade.
Although unnecessary, it will not harm the instrument if the upgrade is performed twice.

1)
2)

3)

4)
5)

Upgrade
Run the APx Performance Checks to proper operation.

Connect the APx instrument to a backup power supply (UPS). Also connect the PC to the backup
power supply, or use a notebook computer with at least 30 minutes battery run time.

Modity the APx500 desktop icon as follows:

a) Right click on the icon and choose Properties.

b) Select the Shortcut tab and change the target from:

"C:\Program Files\Audio Precision\APx500 2.4\AudioPrecision.APx500.exe"

to

"C:\Program Files\Audio Precision\APx500 2.4\AudioPrecision.APx500.exe"/upgradeboot0
(your path and APx version may vary from the example)

Power on the instrument and double click the shortcut to start the APx500 Measurement Software.
The software will open and display a prompt asking “Do you wish to upgrade the firmware?”” Click

ves. While the upgrade is in process, the message “Upgrading instrument firmware” will be
displayed.
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@y Important: Do not interrupt power to the PC or APx instrument during the upgrade.
Doing so may render the instrument inoperative until the BZOD module is replaced.

6) After the firmware upgrade has completed, close the APx500 Measurement Software.

7) Modify the APx500 desktop icon as follows to remove the change made in Step 3 above:
a) Right click on the icon and choose Properties.
b) Select the Shortcut tab and change the target from:

"C:\Program Files\Audio Precision\APx500 2.4\AudioPrecision.APx500.exe"/upgradeboot0
to

"C:\Program Files\Audio Precision\APx500 2.4\AudioPrecision.APx500.exe"

(your path and APx version may vary from the example)

8) Restart the APx500 Measurement Software and run the APx Performance Checks to verify proper
operation.

Judio
precision’
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Service Advisory Bulletin APX-0016
Analog Input Failure Channels 9-16
(Cover replacement)

Date: March 9, 2010

To: All AP Distributors

From: Jim Duncan, Technical Support Hardware Engineer

Applies To: APx586 serial numbers APX6-61025 — APX6-61027, APX6-62026 — APX6-62031.

Action: Audio Precision requires that the covers be replaced on all affected instruments. See also
service advisory bulletin APX-0017.

Summary:

When 12—-15 VDC is applied to the channel 9-16 analog inputs, certain components may fail after a
prolonged period of time due to overheating. The analog inputs on APx586 instruments are DC
coupled, and therefore do not block DC voltages on a DUT’s outputs from entering the instrument. To
improve ventilation and reduce internal temperatures, the covers on early APx586 instruments must be
replaced.

Replacement of the components that may fail is addressed in SAB APX-0017. If both advisories apply
to an instrument, the cover swap described in this advisory may be done while completing APX-0017.

All APx586 instruments manufactured before February 2010 should be checked to determine if SAB
APX-0016 and/or APX-0017 applies.

Tools and Required Materials:

e #1 Phillips screwdriver.

Parts List:
Part Number Description Quan
7150.0300 Top cover 1
7110.0300 Bottom cover 1
5630.0001 Foot, Black .5 x .5 x .25 4

Cover Replacement:

1. Observe the location of the ventilation holes in the top cover and then identify it in Figure 1 below.
If the instrument has the original cover, replace it with the improved one. Then, re-attach the
carrying handle, and affix the four new feet to the side as shown.
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Improved cover

Original cover

®
®

Figure 1 APx586 original (bottom) and improved (top) covers.

2. Observe the location of the ventilation holes in the bottom cover and then identify it in Figure 2
below. If the instrument has the original cover, replace it with the improved one.

Original cover
Improved cover

Figure 2 APx586 original (left) and improved (right) covers

3. Re-calibrate the instrument if required.

’0 St =i 5750 SW Arctic Drive

" Beaverton, Oregon 97005 ap.com
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Service Advisory Bulletin APX-0017
Analog Input Failure Channels 9-16
(Module replacement)

Date: March 9, 2010

To: All AP Distributors

From: Jim Duncan, Technical Support Hardware Engineer

Applies To: APx586 instruments with BCAS module revisions 106111 or 200-202.

Action: Audio Precision requires that the BCAS modules be replaced in all affected instruments.

Summary:

When 12-15 VDC is applied to the channel 9-16 analog inputs, certain components may fail after a
prolonged period of time due to overheating. The analog inputs on APx586 instruments are DC
coupled, and therefore do not block DC voltages on a DUT’s outputs from entering the instrument.
This advisory gives instructions to replace both BCAS modules on the affected instruments.

Some APx586 instruments also have covers that do not allow adequate ventilation. This is addressed in
SAB APX-0016. If both advisories apply to an instrument, the cover swap described in APX-0016
may be done while completing this advisory.

All APx586 instruments manufactured before February 2010 should be checked to determine if SAB
APX-0016 and/or APX-0017 applies.

Tools and Required Materials:
e #1 and #2 Phillips screwdrivers.

e Static-protection wrist strap or other grounding device.

Parts List:
Part Number Description Quan
BCAS.0000 Analog input module (8 channel) 2

Analog Input Module Replacement:

Verification
1. Determine if the instrument’s analog input modules should be replaced as follows:

Go to Help|About in the APx500 software (Figure 1). Scroll down to 8-Channel Analog Input
Module in the Product Components select box. In the Component Details box, read the ID value. It
will start with BCAS and end with the revision number. If the revision is 106—111 or 200-202,
then the upper BCAS module must be replaced. Now, scroll down to the second §-Channel Analog
Input Module entry (channels 9—-16) and read the revision number. If the revision is 106—111 or
200-202, then the lower BCAS module must be replaced.
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Figure 1 APx500 Help|About box.

2. To obtain replacement BCAS modules, contact Jim Duncan (jimd@ap.com) at Audio Precision.
After receiving the replacements, proceed with the next step below.

Replacement

3. Remove the top and bottom covers. Facing the instrument from the front, the BCAS module for
channels 1-8 is the large circuit board on the right side. The BCAS module for channels 9-16 is
located underneath it.

4. Unplug the 16 red and black twisted pair cables shown in Figure 2.

: B

= 5 L E3 X
Figure 2 BCAS Analog Input

module for channels 1-8.

5. Unplug the ribbon cable from the rear of the board, as shown in Figure 3.
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6. Referring to Figure 3, use a #2 Phillips screwdriver to remove the eight screws that secure the
BCAS module (shown in yellow). Lift the module to disconnect it underneath by inserting an IC

Remove the module from the instrument, and place it in an anti-static bag.

8. Take a new BCAS module from its anti-static bag and place it in the instrument, lining up the
mounting holes with the threaded standoffs below.

9. Press the module down firmly so that the connectors underneath mate fully. Confirm that the
BCAS module is firmly attached by gently trying to lift the board near the rear edge. When
correctly attached, the board will stay seated (Figure 4).

¢

S

Figure 4 Seating the rear section of the BCAS module.
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10.
1.
12.

13

14.

15.

16.

17.

18.

19.

Replace the eight screws that secure the module.
Reattach the ribbon cable.

Connect the input wires between the Analog Input Panel module and the BCAS module. Facing the
front of the instrument, start at the left and plug in the BNC wires for channel 1 (the wire pair with
a ferrite core). Then plug in the Balanced wires for channel 1 (the wire pair without a ferrite core).
Now, continue to do the same for the remaining channels. Note that the connectors are keyed to fit
one direction—the black wire will be on the left, and the red wire on the right.

. To replace the BCAS module on the bottom (channels 9-16), turn the instrument over and repeat

steps 4—12.

Note: It is not necessary to make any adjustments on the BCAS modules.

Operation Checks

Attach the AC power cord and the USB cable. Turn on the instrument, and start the APx500
software.

Run the APx Performance Check. The Performance Check is located on the APx Resources Disc,
and may also be downloaded from the AP.com website (http:// www.ap.com/display/file/258). Note
that the version numbers of APx500 and the APx Performance Check must match.

If the Performance Check does not pass, contact Jim Duncan at Audio Precision (jimd@ap.com).
Replace the top and bottom covers.
Note: Verify if the instrument is covered by SAB APx-0016. If so, install the new covers at this time.

The old BCAS modules must be returned to the Audio Precision factory. The RMA number that
was provided with the replacement modules is required to be written on the package to identify it.

Re-calibrate the instrument if required.

5750 SW Arctic Drive
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Service Advisory Bulletin APX-0018
HDMI 192 kHz Measurement Errors

Date: March 9, 2010

To: All AP Distributors

From: Jim Duncan, Technical Support Hardware Engineer

Applies To: APx585 with HDMI, serial numbers 10535-10583 and 12636—-12688.

Action: Audio Precision requires replacement of HDMI modules that are verified defective by the
attached test. About 10% of the instruments in the listed serial number ranges have defective modules.

Summary:

Due to an error by a supplier, some HDMI modules were manufactured with incorrect data line
termination resistors. This can cause reflections that result in measurement errors at the 192 kHz
sample rate. Measurements made at lower sample rates are not affected.

Defective HDMI modules can be identified by running the attached project file. This bulletin describes
how to run the test, and how to replace HDMI modules that test as defective.
Tools and Required Materials:

e HDMI cable.
e #1 and #2 Phillips screwdrivers.

e Static-protection wrist strap or other grounding device.

Parts List:
Part Number Description Quan
BHDM.0000 HDMI module 1

HDMI Module Test and Replacement (if necessary):

Verification

1. Open the included APx HDMI Test project (APx585 HDMI Loopback Test.approj) or download
it from the AP website (http://ap.com/download/splash/461).

Connect an HDMI cable between HDMI Source and HDMI Sink on the APx instrument.
In APx500, select Project > Start Sequence or click the Start Sequence button.

At the conclusion of the sequence, a report will display showing “Pass” or “Fail”.

Al

If all tests pass, the HDMI module is not defective—no further action is required. If any test fails,
contact Jim Duncan (jimd@ap.com) at Audio Precision to obtain a new HDMI module, and then
proceed with the replacement steps below.
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Caution: Perform all hardware removal and installation procedures in an
ESD-protected (electrostatic discharge protected) work area, while observing
all ESD handling requirements as described in ANSI/ESD S20.20-1999. As a
minimum, use a grounded anti-static work mat and wrist strap.

@y Important: Disconnect all power cables and external cable assemblies from the
instrument before starting the hardware removal or installation procedures.

Replacement
6. Remove both the top and bottom covers of the APx instrument. Turn the instrument upside down.
7. Remove the four screws that secure the HDMI front panel to the instrument, as shown in Figure 1.

& | @® ®'@®
Figure 1 Front panel screws

8. Remove the four screws that secure the HDMI circuit board (BVID), as shown in Figure 2.

Figure 2 BVID circuit board screws
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9. Gently lift the end of the BVID board to unplug it from the connector, as shown in Figure 3.

e ik
Figure 3 Unplugging the BVID board

10. Slide the old HDMI module out the front of the instrument. Note that it will be necessary to tilt it,
as shown in Figure 4, to clear the front panel.

uﬁhﬂ,_ - “‘b‘;ﬂ 5 % Q

5 Pl AT T

Figure 4 Removing the old HDMI module

11. Insert the new HDMI module through the front panel, tilting it as shown in Figure 4. Push the end
of the card into the connector, and replace the four circuit board screws and the four front panel
SCTews.

Operation Checks

12. Turn the instrument over so it is right side up.
13. Attach the AC mains cord and power on the instrument.
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Figure 5 BVID LED indicators A0, +3V, +5V, and FPGA OK.

14. Wait at least one minute, and then observe that the state of the LEDs on the BVID circuit board
(Figure 5) is as follows:

A0 =BLINKING SLOWLY
+3V =0N

+5V =0ON

FPGA OK = OFF

If the LED state is not correct, make sure that the connector under the BVID board is fully inserted
into the mating connector on the BRIO module. If necessary, contact Audio Precision technical
support for assistance.

15. Repeat steps 1-5 to verify correct operation of the new HDMI module.
16. Run the APx Performance Check to verify correct operation of the instrument.

17. The old HDMI module must be returned to the Audio Precision factory. The RMA number that
was provided with the replacement module is required to be written on the package to identify it.

18. Re-calibrate the instrument if required.

d,o 5750 SW Arctic Drive
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Service Advisory Bulletin APX-0019
Failure of Digital I/O LED Indicators

Date: July 13, 2010

To: All AP Distributors

From: Jim Duncan, Technical Support Hardware Engineer

Applies To: All APx525, 526, 585, and 586 instruments manufactured before June 2010.
Action: Install this modification on all APx instruments returned for adjustment or repair.

Summary:

The input connector LED indicators on the AES Digital I/O panel may fail due to a detached ribbon
cable. The cable may detach due to rough shipment, or if the instrument is dropped. This bulletin
describes a modification to secure the cable to prevent this from occurring.

Tools and Required Materials:
e Wire cutter.
e #1 and #2 Phillips screwdrivers.

e Static-protection wrist strap or other grounding device.

Parts List:
Part Number Description Quan
5611.0005 Screw-mount cable ties
5113.7112 Screw, Sem 6-32 x 3/8" Phillips

Caution: Perform all hardware removal and installation procedures in an
ESD-protected (electrostatic discharge protected) work area, while observing
all ESD handling requirements as described in ANSI/ESD S20.20-1999. As a
minimum, use a grounded anti-static work mat and wrist strap.
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Digital 1/0 Cable Tie Installation

: : e
Adding new cable ties to the BAES module.

1. Turn on the instrument and start the APx500 software. In Signal Path Setup, switch both the output
and input connectors through the choices of Digital Unbalanced, Digital Balanced, and Digital
Optical. Observe whether the front panel LEDs on the Digital I/O module correctly illuminate to
indicate the connector in use. Turn off the instrument and disconnect the power cord.

. Turn the instrument over and remove the bottom cover.
3. Locate the BAES module behind the AES Digital I/O panel.

Make sure that both ends of the ribbon cable are fully inserted into their sockets. If they are already
fully inserted, and the Digital I/O LEDs did not illuminate correctly in Step 1, then locate source of
the problem before proceeding.

5. Remove and discard the two screws at the locations circled in yellow above, that hold down the
module.

6. Take the two new 6-32 x 3/8" screws (AP p/n 5113.7112), insert them through the two new cable
ties (AP p/n 5611.0005), and install them into the open circuit board mounting holes.

7. Fold the ribbon cable and loosely fasten the cable ties to secure it, as shown in the figure above. Be
careful not to over-tighten the cable ties. Re-check that the cable connectors are still fully seated.

8. Replace the bottom cover and turn the instrument over.

Turn on the instrument and repeat Step 1 above to verify that the Digital /O LEDs illuminate
correctly.

10. Leave the instrument powered on for 30 minutes to warm up, and then run the APx Performance
Check to verify correct operation before returning the instrument to the customer.

11. Re-calibrate the instrument if required.

ﬂUle 5750 SW Arctic Drive
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Service Advisory Bulletin APX-0020
Software Option Module D-sub Failure

Date: July 27, 2010

To: All AP Distributors

From: Jim Duncan, Technical Support Hardware Engineer

Applies To: All APx515 instruments manufactured before July 15, 2011.

Action: Install this modification on all APx515 instruments returned for adjustment or repair.

Summary:

When removing the Software Option module from the rear of an APx515, the body of the D-sub
connector may separate from the circuit board. This bulletin describes the procedure for replacing the
D-sub connector with one that will not separate.

Tools and Required Materials:
e Soldering iron.
e Desolder tool.

e 1/4" nut driver (thin-wall).

Parts List:
Part Number Description Quan
4225.1009.8 D-sub 9p female connector (with threaded mounting holes)
5152.3408 Screw, Nylon 4-40 x 1/4" 2

Caution: Perform all hardware removal and installation procedures in an
ESD-protected (electrostatic discharge protected) work area, while observing
all ESD handling requirements as described in ANSI/ESD S20.20-1999. As a
minimum, use a grounded anti-static work mat and wrist strap.

Software Option Module D-sub Connector Replacement

Turn on the instrument and start the APx500 software.

2. Go to Help>About and look at the Product Components list. If any software options are currently
installed, they will appear in the list as “iButton — Serial Number ...” Note the serial number and
the software options enabled by the iButton (shown in the Component Details box directly below).
There may be more than one iButton listed.
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Audio Precision APx500 v2.8
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Product Components:

APx500 Series USB Driver =
Microsoft \NET Framework Version .
Instrument ID

Calibration Date B

APx 515 Main 10 Board -
iButton - SerialNumber: DA 00 00 02 A8 CO 4F 33

Software options enabled by this iButton:
SW-AML Advanced Measurement Library
SW-HST High Speed Test

SW-ACR Acoustic Response Measurements

Fig 1 Help>About dialog listing iButton(s).

3. Exit the APx500 software and turn off the instrument.

Fig 2 APx515 rear panel with Software Option module.

4. On the rear panel, loosen the two thumb-screws that secure the Software Option module and detach
it by pulling it straight away from the instrument.

5. Remove the three 6-32 nuts (circled in Fig 3) that secure the Software Option module circuit board
(BSWO0.0000) and remove it from the metal enclosure. Save the nuts for reinstallation. Note that it
is not necessary to remove the iButton(s) to perform the modification.

Fig 3 Software Option module (with one iButton installed).
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6.

10.

1.
12.
13.

On the back side of the circuit board, de-solder the 9 pins of the female 9-pin D-sub connector.

Fig 4 BSWO circuit board before modification.

Carefully remove the D-sub connector from the circuit board.

Install the new female 9-pin D-sub connector (4225.1009.8) on the board and solder the pins on the
back side. Clean off all solder flux residue.

Install the two nylon 4-40 x 1/4" screws (5152.3408) through the back of the circuit board into the
threaded holes in the new D-sub connector. Tighten but do not over-tighten the nylon screws.

Fig 5 BSWO circuit board with new connector and nylon screws installed.

Reinstall the circuit board into the metal housing and secure with the three previously removed
6-32 nuts. Tighten but do not over-tighten the nuts.

Reattach the Software Option module to the rear of the instrument and tighten the thumbscrews.
Turn on the instrument and start the APx500 software.

Go to Help>About as described in Step 2 above and verify that the iButtons are still correctly
recognized.

5750 SW Arctic Drive
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Service Advisory Bulletin APX.0022
Power Indicator Failure

Date: November 2011

To: All AP Distributors

From: Jim Duncan, Technical Support Hardware Engineer

Applies To: APx520, 521, 525, 526, 585, and 586 manufactured before September 6, 2011.

Action: Apply to all instruments returned for adjustment or repair. Instruments received only for
calibration do not need to be opened and modified.

Summary:

The ribbon cable to the front panel power indicator LED may detach during shipping. This advisory
gives instructions for adding a cable tie and block to eliminate the possibility of this occurring.
Tools and Required Materials:

e #1 Phillips screw driver.

e Static-protection wrist strap or other grounding device

Parts List:
Part Number Description Qty
5611.0003 Cable tie 1
5611.0004 Cable tie block 1

Caution: Perform all hardware removal and installation procedures in an
ESD-protected (electrostatic discharge protected) work area, while observing
all ESD handling requirements as described in ANSI/ESD S20.20-1999. As a
minimum, use a grounded anti-static work mat and wrist strap.

Cable Tie Upgrade:

1. Run the APx Self Test on the instrument to verify proper operation before opening.

2. Remove the instrument top cover and locate the back of the power switch and LED power indicator
assembly.

3. Clean the adjacent instrument side rail where the tie block will be mounted with isopropyl alcohol.

4. Remove the backing paper from the cable tie block (5611.0004) and affix it to the instrument side
rail as shown in Figure 1.

5. Attach the cable tie (5611.0003) around the ribbon cable as shown in Figure 1. Do not overtighten
the tie. Cut off any excess.
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@ Important: Check that the placement of the ribbon cable does not interfere with
the operation of the power button slide bar.

Fig 1 Power indicator LED cable secured by new cable tie and block.

6. Replace the top cover.
7. Run the APx Self Test (download at http://ap.com/display/file/534) to verify correct operation of
the instrument.

5750 SW Arctic Drive
Beaverton, Oregon 97005 ap.com
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Service Advisory Bulletin APX.0023
Nuisance Failures of APx515 Power Fuse at 230/240 VAC

Date: February 2012

To: All AP Distributors

From: Jim Duncan, Technical Support Hardware Engineer
Applies To: APx515.

Action: Change Bussmann 5x20mm fuses to recommended Littelfuse type on all instruments returned
for adjustment or repair. Use the recommended Littelfuse types when replacing blown fuses.

Summary:

APx515 instruments operating at 230 or 240 VAC may experience nuisance failures of the power fuses
with the originally installed Bussmann brand fuses. The recommended Littelfuse replacements listed in
the table below have better surge current specifications and should greatly reduce the incidence of
nuisance failures.

Voltage Qty | AP Part# | Littlefuse Part # | Description

230/240 VAC 2 4623.0315 | 0218.315 218 Series 5x20mm Time Lag 250 VAC 315 mA
230/240 VAC 2 0213.315 213 Series 5x20mm Time Lag 250 VAC 315 mA
(alternate)

100/120 VAC 1 4620.0250 | 0313.600 313 Series 3AG 14”x% Time Lag 250 VAC 600 mA

5750 SW Arctic Drive
ap.com

Audio
Beaverton, Oregon 97005
pr eC,S,On 800-231-7350 X110217111900
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Service Advisory Bulletin APX.0024
USB Port Transient Protection

Date: December 2012

To: All AP Distributors

From: Jim Duncan, Technical Support Hardware Engineer

Applies To: All APx500 instruments manufactured before December 17, 2012.

Action: Apply to all instruments returned for adjustment or repair.

Summary:

In some circumstances, especially when an instrument is improperly grounded, ESD transients can
damage the USB port. This advisory gives instructions for adding the BTHR Protection Module, which
increases the ESD protection on the USB port.

Tools and Required Materials:

e #1 Phillips screw driver

e Solder iron with small tip

e Multimeter

e Static-protection wrist strap or other grounding device

Parts List:
Part Number Description Qty
BTHR.0000 Protection module 1

Caution: Perform all hardware removal and installation procedures in an
ESD-protected (electrostatic discharge protected) work area, while observing
all ESD handling requirements as described in ANSI/ESD S20.20-1999. As a
minimum, use a grounded anti-static work mat and wrist strap.

Protection Upgrade:

1. Run the APx Self Test on the instrument to verify proper operation before opening.

2. If the instrument has a Software Option Key module on the rear panel, temporarily remove it.

3. Remove the top cover, using a #1 Phillips screwdriver to remove the 22 4-40 screws that secure it.
4

. Remove the six jack screws that secure the Aux Control Out, Aux Control In, and Software
Options D-sub connectors to the rear panel.
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Fig 1 APx500 instrument rear panel, jack screws.

5. Remove the five screws that secure the BZOD module.

Fig 2 BZOD module retaining screws.

6. Lift up the BZOD module to disconnect it from the connector underneath. Pull back on the fan
slightly so that the module clears it.

. Place the BZOD module upside down on a static protective mat.
8. Place the BTHR module in position as shown (Figure 3).

APX.0024 rev 0 Service Advisory Bulletin



BTHR PCB ASSEMBLY
ALIGNS WITH USB PINS

ON BOTTOM OF BZOD.0000
PCB ASSY

Fig 3 Placement of BTHR module.

9. Solder the BTHR module as shown (Figure 4). Solder the two mounting tabs first, and then the
four USB socket pins. Use a small tipped soldering pencil and make contact with both the pin and
the plated hole to prevent a cold solder joint (Figure 5). Use caution not to bridge any of the traces.

APX.0024 rev 0

BTHR PCB MATES
FLUSH TO BOTTOM
OF BZOD.0000 PCB
ASSY

SOLDER FOUR USB PINS
TO BTHR PCB

TWO CLEARANCE HOLES

FOR DISCRETES
SOLDER TWO USB
MOUNTING TABS
TOBTHR PCB

Fig 4 Soldering of BTHR module to BZOD PCB assy.
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Fig 5 BTHR module soldering.

10. Using a multimeter, check that there is continuity between the two large plated holes on the BTHR
and the USB jack shield on the BZOD module. Then check that there is no continuity between any
of the four small plated holes on the BTHR.

11. Clean all traces of solder flux from the board.

12. Reinstall the BZOD module. Making sure that the connector underneath is lined up, and that the
holes in the standoffs are centered under the holes in the module.

13. Secure the module with the five 6-32 x .25" screws that were removed earlier.

14. Secure the Aux Control Out, Aux Control In, and Software Options D-sub connectors to the rear
panel using the six jack screws that were removed earlier.

15. Replace the Software Option Key module on the rear panel if it was removed.

Post-upgrade Tests

16. Reconnect the power cord. Turn on the APx instrument, and check the LED indicators in the top
right corner of the BRIO module, between the power supply module (C) and the support frame (D)
(Figure 6). The LED at point “A” should be blinking (active clock), and the LED at point “B”
should be constantly lit (+5 volts DC).
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Fig 6 Power supply check.

17. If the power supply check passes, reinstall the top cover using the screws that were previously
removed.

18. Download the APx Series Self Test from AP.com and run it to check the entire instrument.

19. If any check fails, verify that the BZOD module has been reinstalled correctly. If the instrument
still fails the checks or otherwise does not function properly, please contact Jim Duncan at Audio
Precision (jimd@ap.com) to obtain factory service.

20. Re-calibrate the instrument if required.

5750 SW Arctic Drive

Audio
PIrecCISION  orirss

ap.com
XI110708095800
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Service Advisory Bulletin APX.0026
4 VVDC on PDM Inputs at Turn-on

Date: October 2015

To: All AP Distributors

From: John Payne, Technical Support Hardware Engineer

Applies To: All APx500 instruments with the PDM option installed.

Action: Modify PDM option revs 000 - 004 if the instrument is returned for service, or if the customer
experiences damage to their device under test.

Summary:

The PDM inputs are buffered by a device operating at +4 VDC, and when the instrument is turned on it
can place + 4VDC on the pins and potentially cause damage to the DUT. This modification corrects
this so that the inputs are at 0 VDC when the instrument is first turned on.

Tools and Required Materials:

o #1 & #2 Phillips screwdrivers

e 4" Hex nut driver

e Solder/desolder equipment for removal of SMT resistors
e 3/16” socket wrench

e #2 Solder Wick

e Static-protection wrist strap or other grounding device

Parts List:
Part Number Description Qty
1176.2001.1 2 k ohm SMT resistor 2

Caution: Perform all hardware removal and installation procedures in an
ESD-protected (electrostatic discharge protected) work area, while observing
all ESD handling requirements as described in ANSI/ESD S20.20-1999. As a
minimum, use a grounded anti-static work mat and wrist strap.

Modification Procedure:

1. Run the APx Self Test on the instrument to verify proper operation before opening.
2. Remove the handle on the side of the instrument using a #2 Phillips screwdriver.
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3. Using a #1 Phillips screwdriver, remove the 22 4-40 screws that secure the top cover and set it
aside.

4. Turn the instrument upside down. Remove the 12 4-40 screws that secure the bottom cover and set
it aside.

5. Locate the PDM module.
6. Add a 2k ohm resistor from R1062 to the pad at U112 pin 3 (U112 is not installed).
7. Add a 2k ohm resistor from R1063 to the pad at U113 pin 3 (U113 is not installed).
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Figure 1 PDM module.
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Clean off any solder flux residue.

9. Remove the DSIO Panel module from the instrument and set it aside in a safe place. This will be
reinstalled after the modifications are complete.

10. Reinstall the top and bottom covers and the handle.

11. Download and run the APx Self Test (http://ap.com/display/file/534) to verify correct operation of
the instrument.

12. If any check fails or the instrument otherwise does not function properly, please contact Hardware
Technical Support at Audio Precision (service@ap.com) to obtain factory service.

13. Recalibrate the instrument if required.
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Service Advisory Bulletin APX.0027
5 VDC on DSIO Inputs at Turn-on

Date: October 2015

To: All AP Distributors

From: John Payne, Technical Support Hardware Engineer

Applies To: All APx500 instruments with the DSIO option installed.

Action: Modify DSIO option modules rev 000, 001, and 100 if the customer experiences damage to
their device under test.

Summary:

The DSIO inputs are buffered by a device operating at +5 VDC, and when the instrument is turned on
it can place + 5VDC on the pins and potentially cause damage to the DUT. This modification corrects
this so that the inputs are at 0 VDC when the instrument is first turned on.

Tools and Required Materials:

o #1 & #2 Phillips screwdrivers

e 4" Hex nut driver

e Solder/desolder equipment for removal of SMT resistors
e 3/16” socket wrench

e #2 Solder Wick

e Static-protection wrist strap or other grounding device

Caution: Perform all hardware removal and installation procedures in an
ESD-protected (electrostatic discharge protected) work area, while observing
all ESD handling requirements as described in ANSI/ESD S20.20-1999. As a
minimum, use a grounded anti-static work mat and wrist strap.

Modification Procedure:

1. Run the APx Self Test on the instrument to verify proper operation before opening.
2. Remove the handle on the side of the instrument using a #2 Phillips screwdriver.

3. Using a #1 Phillips screwdriver, remove the 22 4-40 screws that secure the top cover and set it
aside.

4. Turn the instrument upside down. Remove the 12 4-40 screws that secure the bottom cover and set
it aside.

5. On the DSIO Main module board, release the clamp on the ribbon cable connector and disconnect
the ribbon cable (Figure 1).
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Figure 1 DSIO module ribbon cable.

6. Remove the four jack screws that secure the Transmitter and Receiver d-sub connectors to the front
panel using a 3/16” socket wrench.

7. Remove the DSIO Panel module from the instrument and set it aside in a safe place. This will be
reinstalled after the modifications are complete.

8. Remove the four jack screws that secure the Monitor connectors to the front panel using a 3/16”
socket wrench.

9. Remove the four #1 Phillips head screws securing the front panel and remove it.

10. Position the instrument with the front facing you and identify the locations of the sixteen resistors
to be removed. Please see Figure 2 as a reference locator.
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Figure 2 Resistors on the DSIO main board that will be removed.
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11.

12.

13

14.
15.

16.

17.
18.
19.

20.

21.

With a fine tipped solder pencil, use a small size solder wick to remove the solder from one side of
each resistor until there is no longer any solder in the joint. Next, repeat the solder removal
operation on the second joint of each resistor. Then apply the solder pencil tip to the first joint
while using a pair of fine point tweezers to gently apply some rotational force to the body of the
resistor. The resistors should come free from the solder pads.

Safely dispose of the resistors.

. Inspect the area were the resistors were removed for any signs of loose solder or flux material and

clean it as necessary to avoid any short circuits.
Reinstall the DSIO Front panel using the four #1 Phillips head screws.

Using the 3/16” socket wrench, reinstall the four jack screws to fasten the Monitor D-sub
connectors to the panel.

Reinstall the DSIO Panel module and secure the Transmitter/Receiver D-sub connectors to the
front panel using the last four of the jack screws.

Reinsert the ribbon cable on the DSIO Main module.

Reinstall the top and bottom covers and the handle.

Download and run the APx Self Test (http://ap.com/display/file/534) to verify correct operation of
the instrument.

If any check fails or the instrument otherwise does not function properly, please contact Hardware

Technical Support at Audio Precision (service@ap.com) to obtain factory service.
Recalibrate the instrument if required.

5750 SW Arctic Drive
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Service Advisory Bulletin (APX-0028)
New APx-555 firmware must use v4.3 software

Date: 7/14/16
To: All Audio Precision Distributor Service Engineers

From: John Payne, Technical Support Hardware Engineer
Applies to: APx555 Analog Input Assembly (B4Al) replacement boards

Action: If the customer is using a version of APx500 software earlier than v4.3 a
software patch must be installed.

Summary

Production has noted that some of our supplied A to D converters are not making our
current noise specification (rise above 20 kHz). The failing parts are more sensitive to
clock jitter and the results are a higher noise figure. Engineering has found a hardware fix
that involves a rework of the FPGA firmware program that will need to be installed with
the release of APx500 v4.3.

All APx555 Analog Input Assemblies (B4Al) produced beginning in July 2016 will have
this new firmware installed, and will require that the instrument be run with version 4.3
or later.

If the customer is using 4.0, 4.1.1, or 4.2.1 versions of APx500 control software they will
see a notification of “Unsupported hardware Configuration” when loading these earlier
versions of software and using the modified Analog Input Assemblies (B4Al).

If the customer wants to continue to use any of the earlier versions of 4.0, 4.1.1, or 4.2.1
and does not want to upgrade to version 4.3. Then they need to download the patch file
“FirmwareUpdateB4AIv2.0.zip”from the Audio Precision web site at ap.com, and follow
the instructions provided with the patch file.






Service Advisory Bulletin (APX-0029)
Fix for APx515 models with intermittent AES optical
operation using APx 4.2 (or higher) control software

Date: 5/15/17

To: All Audio Precision Distributor Service Engineers
From: John Payne, Technical Support Hardware Engineer
Applies to: All APx515 models produced before 4/20/17.

Action: Certain APX515 models will have intermittent AES optical operation using
clock rates from 39Kk to 47k, 49k to 59k, and from 103k to 109.3k. This is being caused
by a one bit shift in the sample rate. A hardware fix has been released to correct the
intermittent operation.

Summary:

Two SMT resistors need to be changed on the BXAN board to correct this problem.
Resistor pack RP 122 was 27 ohms and needs to be replaced with a 47 ohm model, AP
part number 1974.0470.1

SMT resistor R 1221 was a 10k ohms and needs to be replaced with a 1k ohm, AP part
number 1176.1001.1. Remove any flux residue from the rework area on the circuit board.
No adjustments are necessary after this modification.

Tools needed:

#1 and #2 Philips screwdriver.

Hot air gun or solder wick.

Soldering pencil.

Static-protection wrist strap or ESD safe work space.

Caution: Perform all hardware removal and installation procedures in an ESD-protected
(electrostatic discharge protected) work area, while observing all ESD handling
requirements as described in ANSI/ESD S20.20-1999. As a minimum, use a grounded
anti-static work mat and wrist strap.
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Service Advisory Bulletin (APX-0030)
New APX assemblies are now RoHS compliant

Date: 3/10/17
To: All Audio Precision Distributor Service Engineers
From: John Payne, Technical Support Hardware Engineer

Applies to: All Audio Precision Products excepting the legacy products lines of the
System Two family, the DCX-127, and the 2755 Switcher series.

Action: Beginning in mid-2017 Audio Precision will begin production of circuit board
assemblies that are RoHS compliant. All future repairs on these assemblies must be also
RoHS compliant. No exceptions allowed.For non-RoHS instruments with green
assemblies, repairs can be made with non-RoHS materials.

Summary

To identify if the product in question is of a RoHS type, all circuit assemblies that are
RoHS compliant are Blue or Violet in color.

All Non-RoHS compliant board will remain Green in color.

Ui

Non-RoHS assembly RoHS assembly






Service Advisory Bulletin (APx-0031)
High THD readings on APx1701

Date: February 2018

To: All Audio Precision Distributor Service Engineers
From: John Payne, Technical Support Hardware Engineer
Applies to: APX1701 sn 10000 thru 10099

Action: Modify speaker output connections on the Titan power amplifier board, the
output cable harness, and the SpeakOn panel connector.

Summary

The 1701 unit will not pass THD specs at full output into low impedance loads (4 ohm).
This is caused by oxidized connections at the output spade lug terminals at the power
output cable interface and at the front panel SpeakOn connector.

All APX1701 units with serial numbers higher that 10100 will have the SpeakOn cable
connector wires soldered in place and the Titan board has had the output lug connections
replaced with screw on connectors.

Tools and required Materials

e # 1 Philips screw driver
# 2 Philips screw driver
Needle nose pliers
Wire cutters/wire stripper
High wattage soldering tool

Pretesting

Conduct the APX1701 Self-Test Performance Check program on the instrument to verify
proper operation before the modification. This will require using the APx1701 Self-Test
Kit.

Procedure
1. Using a #2 Phillips screwdriver, remove the ten black screws on the top cover and
the four screws on the top front panel. Remove the cover and screws and set them
aside for later reassembly.

2. To modify the front panel SpeakOn output connector, remove the four speaker
wire connections to the Titan power amplifier module. Using the needle nose
pliers remove the red and black spade lug connectors for channel A and the blue
and white spade-lug connectors for channel B from the Titan module.



3. Remove the SpeakOn connector by removing the four #1 Phillips screws and
nuts, set the fasteners aside for reassembly later. Carefully remove the connector
and wires through the front panel mounting hole.

4. Make a note of where each wire is connected to each lug on the connector (see
figure #1). Remove each spade-lug connector from the SpeakOn connector.

Figure 1

1. Using the wire cutters, cut off each of the eight spade-lug connectors from the red,
black, blue, and white wires.

2. On each end of the four wires, strip .25 inch (1.5 cm) of insulation off and pre-tin
the wire with solder. Following your notes for each wire location solder each wire
to the spade lug on the SpeakOn connector as seen in figure 2.



Figure 2

Reinsert wires through the front panel one set at a time, then reattach SpeakOn connector
to front panel.

Re-solder SpeakOn cable wires to the Titan board as shown in figure 3.
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Figure 3

Re install cover and screws.

Conduct the APX1701 Self-Test Performance Check program on the instrument to verify
the proper operation after the modification is complete. This will require using the
APx1701 Self-Test Kit.



Service Advisory Bulletin (APX-0032)
APx500 B series BZD2 (USB 3) interface modules.

Date: 12/1/18
To: All Audio Precision Service Engineers
From: John Payne, Technical Support Hardware Engineer

Applies to:.
All APx500 B series instruments that have an USB interface failure.

Action:

A new BZOD-2 replacement module must be ordered directly from the AP factory

specifically for each instrument.

The following information will be needed at the time of ordering a replacement module.
1. Model and serial number of the unit needing the replacement interface module.
2. Current version of software that the customer is using.

Summary:

All Apx500 B series instruments BZOD-2 interface modules contain internal software
key box technologies that are encrypted. The internal programming for the BZOD-2
module can only be done at the Audio Precision factory. Each BZOD-2 will have the
instrument model and the instrument serial number preprogramed into its on-board
memory. In addition, all APx500 software options that were pre-purchased will need to
be programmed into the replacement BZOD-2 before shipment to the service center.

Figure 1. BZD2 UDB interface module.
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